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1. INTRODUCTION 
 

The Epsilon EClipse™ is the latest potentiostat designed by Bioanalytical Systems Inc. to enable scientists to 

conduct cutting edge electrochemistry experiments in the laboratory. It has upgraded hardware, updated software, 

an expanded applied potential range, and improved design compared to the Epsilon. This manual is intended to aid 

the electrochemist in utilizing the Epsilon EClipse™ to its utmost potential. 

 
Additional accessories for electrochemistry experiments using the Epsilon EClipse™ are available from BASi. These 

include the C3 cell stand, the controlled growth mercury electrode (CGME), a rotating disk electrode (RDE2), and 

many different electrodes. These are mentioned where appropriate throughout the manual. 

 
1.1 TECHNIQUES 

Basic Software: 

Potentiostat 

Cyclic Voltammetry (CV) 

Linear Sweep Voltammetry (LSV) 

Chronoamperometry/Chronocoulometry (CA/CC) 

Controlled Potential Electrolysis (CPE) 

DC Potential Amperometry (DCPA) 

 
Galvanostat 

Chronopotentiometry (CP) 

Double Step Chronopotentiometry (DSCP) 
 

Other 

Open Circuit Potential Vs Time (OP) 
 

Basic Plus Software: 

Pulsed Voltammetry 

Square Wave Voltammetry (SW) 

Normal Pulse Voltammetry/Polarography (NP) 

Differential Pulse Voltammetry/Polarography (DP) 

Sampled Current Polarography (SCP) 

 
Stripping Voltammetry 

Linear Sweep Stripping Voltammetry (LSSV) 

Square Wave Stripping Voltammetry (SWSV) 

Differential Pulse Stripping Voltammetry (DPSV) 

 
Methods Software: 

Sequential Techniques 

 
Bipotentiostat Techniques : 

Multi-Channel Amperometry (MCA) 

Multi-Channel Cyclic Voltammetry (MCCV) 

Multi-Channel Chronoamperometry (MCCA) 
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1.2 FEATURES 

Nineteen techniques 

±10 V applied potential range 

±12V compliance voltage range 

Update user friendly software 

100 µv potentiostat resolution 

Hardware interfaces with BASi Voltammetric Cell Stand, Controlled Growth Mercury Electrode Cell Stand, and 

Rotating Disk Electrode Cell Stand 

Control of magnetic stirring and gas purging with BASi cell stands 

Automatic and manual peak fitting 

Anson and Cottrell Plots 

Digital smoothing 

Semi-integration, and semi-differentiation 

 

1.3 SPECIFICATIONS: 

Potentiostat: 

Channel 1 applied potential: Dynamic DAC: 16 bit, ±3.275 V 

at 0.1 mV resolution or ±10V at 0.33 mV resolution 

Offset DAC: 8 bit, ±2.55 V at 10 mV resolution 

Channel 2 applied potential: Dynamic DAC: 8 bit, ±2.55 V at 

10 mV resolution 

Compliance voltage: ±12 V 

Maximum current: 100 mA 

Bandwidth: >1012 W 

(values for parameters other than applied potential 

are for both channels) 

 
Current to voltage converter: 

Full scale sensitivity: 1 nA*, 10 nA*, 100 nA, 1 

µA, 10 µA, 100 µA, 1 mA, 10 mA, 100 mA 

(*secondary gain used) 

Secondary gain: x1, x10, and x100 

ADC resolution: 16 bit 

Sampling rate: 50 kHz (20 µs/conversion) 

Data length:  64,000 points – fast 

 
 

Galvanostat: 

Applied current: 50 pA – 50 mA 

Voltage range: ±10 V or ±1 V 

Measured voltage resolution: 0.02 mV 

Maximum leakage current: 30 pA 

 
Minimum PC requirements: 

Windows 7 or higher 

USB port 

 
Power requirements: 

120 or 240 V AC, 50/60 Hz, 60 VA 

 
Dimensions & Weight: 

15.75” (40 cm) x 5.25” (13 cm) x 12.75” (32.5 cm) 

17.5 lbs (7.4 kg) 

 

1.4 WARRANTY 

BASi® warrants equipment manufactured by the company to be free of defects in material and workmanship for a 

period of one year from the date of shipment, except as provided hereinafter. This assumes normal usage under 

commonly accepted operating parameters and excludes consumable products. BASi® further warrants that it has 

clear title to the goods and the goods shall be delivered free of liens and encumbrances. BASi® does not warrant 

either a good effect or against any ill effect following use of the goods. 

 
All products manufactured by BASi® are tested and inspected prior to shipment. However, in the event a prod- 

uct is delivered to buyer with a defect, upon prompt notification by the buyer, BASi® will correct any defect in 

products or equipment of its manufacture either, at its option, by return of the item to the factory, or shipment 

of a repaired or replacement part. BASi® will not be obliged, however, to replace or repair any piece of equipment 

which it determines has been abused, improperly installed, altered, damaged, or repaired by others. Defects in 
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equipment do not include decomposition, wear, or damage by chemical action or corrosion, or damage incurred 

during shipment. 

 
BASi® agrees either to repair or replace, at its sole option and free of part charges to the buyer, any parts of such 

instrumentation which, under proper and normal conditions of use, prove to be defective within 90 days from the 

date of shipment. 

 
BASi® neither assumes nor authorizes any person to assume for it any other liability in connection with the sale, 

installation, service or use of its instrumentation. BASi® shall have no liability whatsoever for special, consequential, or 

punitive damages of any kind from any cause arising out of the sale, installation, service or use of the goods or services. 

 
THE WARRANTY AND REMEDY PROVIDED HEREIN ARE SOLE AND EXCLUSIVE WARRANTY AND REMEDY MADE 

BY BASi® AND IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING THE WARRANTY OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

 
Limited Obligations Covered by this Warranty 

1. In the case of instruments not of BASi® manufacture, the original manufacturer’s warranty 

applies. 

2. Shipping charges under warranty are covered only in one direction. The buyer is responsible for 

shipping charges to the factory if return of the part is required. 

3. This warranty does not cover damage to valves, lamps, seals, or columns due to improper instal- 

lation by the buyer. 

4. Warranty for thin-layer amperometric cells and working electrodes are limited to 60 days. 

5. Warranty for valves is limited to 30 days. 

6. Expendable items, including but not limited to microdialysis probes, catheters, tubing sets, 

reference electrodes, chemical standards, prepared solutions, lights, fuses, O-rings, gaskets, glass 

items, membranes and filters, are excluded from warranty. 

7. Failure by the buyer to perform normal and reasonable maintenance on instruments will void 

warranty claims. 

8. If the original invoice for the instrument is issued to a buyer which is not the end user, and not 

an authorized BASi® distributor, then all requests for warranty must be processed through the 

company which sold the product to the end user, and not through BASi® or its distributors. 

 
1.5 SERVICE INFORMATION 

BASi has skilled staff available to assist with technical support for your BASi equipment. For service, call (765) 

463-4527 and ask for Customer Service. Following discussion of your specific difficulties, an appropriate course of 

action will be described and the problem will be resolved accordingly. 

 
Do not return any products for service until a Return Authorization Number (RA#) has been obtained. The RA# 

identifies you as the sender and describes the problem you are having in full detail. All correspondence and ship- 

ments should be sent to: 

Service Department 

Bioanalytical Systems, Inc. 

2701 Kent Avenue 

West Lafayette, IN 47906 

RA#  ’ 
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2. SAFETY PRECAUTIONS 
 

The following general safety precautions must be observed during all phases of operation, service, and repair 

of this instrument. Failure to comply with these precautions or with specific WARNINGS, CAUTIONS, or NOTES 

elsewhere in this manual may impair the protection provided by the equipment. Such noncompliance would also 

violate safety standards of design, manufacture, and intended use of the instrument. 

 
Bioanalytical Systems, Inc. assumes no liability for the customer’s failure to comply with these requirements. 

• For indoor use only. 

• Ground the Instrument. To avoid electric shock, the instrument must be grounded with the 

supplied power cable’s grounding prong. 

• DO NOT exceed the operating input power, voltage, current level and signal type appropriate for 

the instrument. Refer to the Installation Section for further information. 

• Electrostatic discharge (ESD) can damage the highly sensitive microcircuits in your instrument. 

ESD damage is most likely to occur as the instruments are being connected or disconnected. 

Ground yourself to discharge any static charge built-up by touching the outer shell of any 

grounded instrument chassis before the I/O connectors are connected or disconnected. 

• DO NOT place the instrument in fluid or expose the internal elements or back panel to fluid. 

• DO NOT Operate in an Explosive Atmosphere. Do not operate the instrument in the presence of 

inflammable gasses or fumes. Operation of any electrical instrument in such an environment 

clearly constitutes a safety hazard. 

• Keep Away from Live Circuits. Operators must not remove instrument covers. Component replace- 

ment and internal adjustments must be made by qualified maintenance personnel. Do not replace 

components with the power cable connected. Under certain conditions, dangerous voltage levels 

may exist even with the power cable removed. To avoid injuries, always disconnect the power 

and discharge circuits before touching them. 

• DO NOT Substitute Parts or Modify the Instrument. To avoid the danger of introducing additional 

hazards, do not install substitute parts or perform unauthorized modifications to the instrument. 

Return the instrument to Bioanalytical Systems, Inc. Service Department for service and repair to 

ensure that safety features are maintained in operational condition. 

 
If you notice any unusual conditions as listed below, immediately terminate operation and disconnect the power 

cable. Contact the Bioanalytical Systems, Inc. Service Department for repair of the instrument. If you continue to 

operate without repairing the instrument, there is a potential for hazard or damage to both the equipment and the 

operator. 

• Instrument operates abnormally 

• Instrument emits abnormal noise, smell, smoke or a spark-like light during operation 

• Instrument generates high temperatures or electrical shock during operation 

• Power cable, plug or receptacle on instrument is damaged 

• Foreign substance or liquid has penetrated the outer cover of the instrument 
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WARNING – This signifies extreme 

hazard. Not following the instructions 

may result in serious injury or death. 

CAUTION – Following information relates 

to a hazard. If instructions are not 

followed properly, it can result in 

irrevocable damage to the instrument. 

NOTE – This implies that the following 

instructions are essential for the user 

to understand in order to operate the 

equipment effectively. 

Throughout the course of this manual, the following words and symbols will be used to designate important information: 

 

 

 

 

 

SYMBOLS 
 
 
 

Caution: Risk of danger. User’s manual must be consulted in all cases where this symbol is marked. 

 

 

 
Fuse 

 

 

 
Alternating current 

 

 

 
On (supply) 

 

 

 
Off (supply) 

 

 

 
Complies with European Union directives 

 

 

 
The European Waste Electrical and Electronic Equipment (WEEE) Directive 
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3. INSTALLATION 

Connections to the cell and the cell stands (C3, RDE-2, CGME) are made on the front panel of the Epsilon EClipse™ 

system. All other connections, including the power and USB port, are made on the rear panel. 

 

 

 
3.1. POWER 

The Epsilon EClipse™ system requires a grounded power supply, providing either 120VAC at 60Hz or 240VAC at 

50Hz. Before connecting the supplied power cord, check that the indicator next to the power connection shows 

the correct voltage. 

 

 

If you need to change the power input for any reason, please contact BASi for assistance. 
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WARNING: NEVER CONNECT OR ADJUST 

THE CELL LEADS DURING AN EXPERIMENT 

OR WHEN THE CELL IS ON. DOING SO 

COULD DAMAGE THE SENSITIVE 

AMPLIFIERS AND VOID YOUR WARRANTY. 

3.2. COMPUTER 

The Epsilon EClipse™ system requires a computer running Windows 7 or later. Connect a standard USB cable 

between any USB port on the computer and the USB port on the back of the Epsilon EClipse™. The Epsilon EClipse 

software is included on a USB stick with each purchase. For the most up-to-date version of the software, please 

email ec@basinc.com. 

 

3.3. CELL CONNECTION 
 

The cell connection on the Epsilon EClipse™ can be found on the lower front panel of the instrument. The cell 

lead cable is the group of wires that connects the Epsilon EClipse™ to the electrodes of the electrochemical cell. 

The Epsilon EClipse™ has been supplied with a single-channel cell lead cable or a dual-channel cell lead cable, 

depending on whether it is a standard potentiostat or a bipotentiostat. 
 

 

The general purpose cell lead cable is terminated with alligator clips that attach directly to the cell electrodes. 

 

 

 

 

 

 

SINGLE-CHANNEL 
CELL LEAD (ER- 
9861) 

There are 3 electrode leads and 1 

grounded (shielding) lead. 

 
Black: Working Electrode 

Red: Auxiliary electrode 

White: Reference electrode 

Ring: Ground connector 

BIPOT CELL LEAD 
(ER-9860) 

There are 4 electrode leads and 1 

grounded (shielding) lead. 

 
Black W1: Working Electrode W1 

Black W2: Working Electrode W2 

Red: Auxiliary electrode 

White: Reference electrode 

Ring: Ground connector 

CELL STAND CABLE 
(ER-9862) 

This cable is available for direct 

attachment to the LEMO port on a 

BASi cell stand. 

mailto:ec@basinc.com
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3.4. ANALOG INPUT/OUTPUT 
 

 
Analog inputs and outputs can only be used for potentiostatic techniques. An analog output is provided for the 

W1 and W2 channels (W3 and W4 are unavailable on the Epsilon EClipse™), and must be activated from within the 

software (see Manual Control in section 7.2). These outputs have a full scale output of ± 10 V and are provided for 

connection to chart recorders and other data-acquisition devices. The W1 or W2 terminal should be connected to 

the “high” or “+” input of the peripheral device, and the GND terminal to the “low” or “-” input (do not use any 

additional grounding that may be available on the peripheral device). 

 
The E OUT output is provided to monitor the potential applied to the cell on W1 (or the potential of the working 

electrode in the Open Circuit Potential technique), and the E IN input is provided to apply a potential to W1 from 

an external source (this external potential is summed to the potential applied by the Epsilon EClipse™). Please be 

aware that noise may be introduced into the system when E IN is activated. 

 
3.5. REMOTE START/STOP 

 

 
The remote start and stop connections provide several alternatives for sending and receiving signals to and from 

other instruments. These functions are fixed in time and cannot be modified. For programmable triggers to remote 

instruments, see Timed Events below. 

 
START IN 

Allows an external device to trigger the start of an experiment. Note that this is not the start of data acquisitions, 

and several hundred milliseconds plus the Quiet Time may elapse from the trigger until data acquisition starts. A 

switch closure or TTL-low of at least 55ms across the START IN terminal and its ground will trigger the run. 

 
START OUT 

Used to trigger other instruments at the start of an experiment. It provides a 1 second TTL-low. 
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STOP IN 

Not applicable for the Epsilon EClipse™. 

 
STOP OUT 

Used to trigger other instruments at the end of an experiment. It provides a 1 second TTL-low at the end of the 

run. The time between the last data point acquired and this signal depends upon the technique and its parameters. 

 
3.6. TIMED EVENTS 

 

 
Timed Events are programmable switch closures that provide exceptional flexibility for controlling peripheral 

instruments. Four switches are provided, which can be connected in a normally-open (NO) or a normally-closed 

(NC) configuration. Two possible configurations to create TTL signals are shown below. 

 

 

 
 

 
 

With both configurations the trigger line will normally be at 5V and will step to 0V when activated. In the figure on 

the right, the resistor (1 - 10k) is required to limit the current drawn from the 5V power supply. These switches 

may be manually activated in the software, or programmed as part of Sequential Techniques (see section 7.4 and 

section 7.6). 

 
3.7. STARTING THE EPSILON ECLIPSE™ 

Once the Epsilon EClipse™ is plugged into the USB port on your computer and powered on, you can open the 

Epsilon EClipse™ software. The software will automatically connect to the instrument. You should see the message 

“Epsilon Connected” in the bottom left corner of the software. If you receive the following message when you open 

the software, please check the power and USB connections. 



BASi | Epsilon EClipse PART 3 | INSTALLATION 

12 

 

 

 

 
 

 
If the connection is broken after it has been established, the PC and the Epsilon EClipse™ can be reconnected 

using Reconnect Epsilon in the Instrument menu. 
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4. EPSILON ECLIPSE™ CHEMICAL TEST PROCEDURE 
 

PURPOSE 

The purpose of this test is to perform a final examination of the Epsilon EClipse™ before going to the 

customer, and to provide the customer with typical output and data. From these outputs, the customer 

can verify that the instrument is working properly on arrival and can gain some experience in its 

operation. 

 
INSTRUMENT INSTALLATION 

Please follow the installation instructions at the beginning of this manual. If available, a BASi cell stand 

should be connected to the CELL STAND port on the front of the Epsilon EClipse™. 

 
TEST SOLUTION 

2 mM potassium ferricyanide with 1 M potassium nitrate in water. 

 
PREPARATION OF THE TEST SOLUTION 

1. Weigh 16.5 mg potassium ferricyanide and place in a 25 mL volumetric flask. 

2. Weigh 2.53 g potassium nitrate and add to the same volumetric flask. 

3. Add about 20 mL deionized water to dissolve the potassium ferricyanide and potassium nitrate. 

4. Dilute to 25 mL with deionized water. 

 
CELL (C3 CELL STAND) 

Platinum (PTE) Working Electrode (Black lead) 

Platinum Wire Auxiliary Electrode (Red lead) 

Silver/Silver Chloride RE-5B Reference Electrode (White lead) 

 
Add 10-15 mL of the ferricyanide solution to the cell vial and place in the cell holder (see Cell Stand 

instructions). Polish the PTE with 0.05 µm alumina following the polishing instructions provided in the 

polishing kit. 

 
If the RE-5B electrode is new, carefully remove the yellow plastic sheath before use. In addition, there 

may be air bubbles inside the electrode next to the CoralPor™ frit; these must be displaced (by flicking 

the electrode). RE-5B electrodes must be stored in 3M sodium chloride when not in use. 

 
PROCEDURE 

1. Turn the Power switch on the Epsilon EClipse™ to on. 

 
2. Open the Epsilon EClipse™ software by clicking the EpsilonEC icon. The software will automatically connect to 

the instrument. You should see the message “Epsilon Connected” in the bottom left corner of the software. If 

you receive a message that the software is unable to connect to the instrument, please check the power and 

USB connections. If the link is lost after being established, use Reconnect Epsilon in the Instrument menu to 

reestablish the link. 
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3. Click New in the File menu to set up a new experiment. The list of available techniques is displayed (Fig 1). 

It should be noted that there are some techniques that are labeled as DEMO. This label indicates that this 

technique is NOT active on this particular Epsilon EClipse™. However, it is possible to load a data file for that 

technique to examine the parameters and the typical output. If the RUN button is clicked when a DEMO data 

file is displayed in the active window, an error message will be shown. The technique list shown in Figure 1 is 

the list for the Basic-Plus and Methods Epsilon EClipse™ software. 

 

 
 

 
Figure 1 – Selecting a New Technique 

 
4. Select Cyclic Voltammetry. The new .etech file can now be edited. Enter the values shown in Figure 2. Note 

that Switching Potential 2 is not required since there are only 2 segments (Initial Potential to Switching 

Potential 1 to Final Potential). Various experimental data can be entered into the Experimental Conditions 

section. These notes will also be saved when the experimental data is saved. Once these changes have been 

entered, an experiment using these parameters can be run by clicking the RUN button. An experiment can be 

run using either Run in the Experiment menu, or the RUN icon on the Tool Bar. This icon will change to STOP 

during the experiment, and can be used to abort the experiment. 
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Figure 2 - Editing the .etech for Cyclic Voltammetry 

 
5. After the experiment has been run, the voltammogram will be displayed (Figure 3). Note the information about 

the experiment and the peak parameters on the right side of the graph. 

 

 

Figure 3 - Cyclic Voltammetry graph 

 
6. A specific area of the graphic can be enlarged by using the mouse cursor (and the left mouse button) to define 

the area (Figure 4), by using the mouse scroll to zoom in and out, or by entering the x and y values in the Data 

Display Settings dialog box in the Graph menu (Figure 5). The original graph can be restored using Zoom Full 

Range in the Graph menu. 
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Figure 4 - Enlarged section of the Cyclic Voltammetry graph 
 
 
 

 

 
Figure 5 - Data display settings dialog box 

 
7. Use Save in the File menu to save the data in the active .edata window. The data can be converted to a number 

of different text formats using Save Data As in the File menu (Figure 6). Select the desired options and the 

delimiter, and then click OK to save the converted Data. 
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Figure 6 - File conversion 

 
8. Click on the open .etech window. To the right of the graph, find the scan rate parameter box and change the 

Scan Rate to 200 mV/s. Run the experiment again. Note that the new data is displayed in a new .edata window. 

Save this data. Change the scan rate to 500 mV/s, run the experiment, and save the data. 

 
9. The three data sets run at different scan rates can be displayed on the same sets of axes using the File Overlay 

function in the Graph menu. All open *.edata files will be added to the overlay (Figure 7). 

 

 

Figure 7 - Overlayed cyclic voltammograms 
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10. Click New in the File menu, and select Cyclic Voltammetry again. Enter the parameters shown in Figure 

8, and run this experiment. Since there are 3 segments, 4 potential parameters must be defined (Initial 

Potential-Switching Potential 1-Switching Potential 2-Final Potential). 

 

Figure 8 - New Cyclic Voltammetry Parameters 

 
11. Click New, and select Chronoamperometry/Chronocoulometry from the list of techniques. A third window will 

appear. Enter the parameters shown in Figure 9. Running the experiment generates the plot shown in Figure 10. 

 

Figure 9 - Parameters for Chronoamperometry/Chronocoulometry 
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Figure 10 - Chronoamperometry/Chronocoulometry graph 

 
12. The data from a Chronoamperometry/Chronocoulometry experiment can be plotted in a number of different 

formats, which can be selected using Select Graph Type in the graph menu, or by right-clicking on the graph. 

The Q vs. sqrt(T) plot is shown in Figure 11. 

 

Figure 11 - Q vs. sqrt(T) plot for Chronoamperometry/Chronocoulometry 

 
13. The Epsilon EClipse™ software can calculate the slope and intercept of the linear Q vs sqrt(T) plot when it 

is displayed. Selecting Calculate CA-SIR from the Analysis menu generates the information box shown in 

Figure 12. The lines used for the linear fitting are the dashed blue lines in Figure 12 (note that the first 20% 

of the data points are not used in the calculation, due to interference from the charging current and other 

experimental artifacts). 
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Figure 12 - Calculation of slope and intercept of linear plot 

 
14. Click New, and select Chronopotentiometry. A fourth experiment window will be opened. Enter the parameters 

shown in Figure 13, then run the experiment (note the sign convention for the current - cathodic (reduction) 

currents are positive for polarographic). Typical data for a Chronopotentiometry experiment is shown in 

Figure 14. 

 

 
Figure 13 - Parameters for Chronopotentiometry 
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Figure 14 - Chronopotentiometry graph 

 
15. Click New, and select Square Wave Voltammetry (note that this requires the optional Basic Plus software). A 

fifth experiment window will be opened. Enter the parameters shown in Figure 15, then run the experiment. 

Typical data for a Square Wave Voltammetry experiment is shown in Figure 16. 

 

 
Figure 15 - Change Parameters dialog box for Square Wave Voltammetry 



BASi | Epsilon EClipse PART 4 | CHEMICAL TEST PROCEDURE 

22 

 

 

 

 
 

Figure 16 - Default plot for Square Wave Voltammetry 

 
16. The default plot for a Square Wave Voltammetry experiment is the difference current; that is, the current on 

the forward cycle less the current on the reverse cycle. The forward and reverse currents are also available by 

right-clicking on the graph, or by selecting Select Graph Type from the Graph menu. The forward current data 

set is shown in Figure 17. 

 

 
 

 
Figure 17 - Forward current plot for Square Wave Voltammetry 

 
This completes the chemical test. All printed output should be shipped with the instrument. The power cord and 

cell lead (with alligator clips on the cell end) are shipped with the Epsilon EClipse™. 
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5. INTERFACING BASI ACCESSORIES WITH THE EPSILON ECLIPSE™ 
 

5.1. CELL STAND (C3 AND CGME) 

Various operations of the BASi cell stands (purge, stir, and knock/dispense) can be controlled from the Epsilon 

EClipse™. 

1. Connect the Cell Stand (C3 or CGME) to the Epsilon EClipse™ using the 25-pin ribbon cable 

provided with the Cell Stand between the CELL STAND port on the front panel of the Epsilon 

EClipse™ and the REMOTE port of the cell stand. 

2. Connect the DIN-LEMO cable (ER-9862) between the CELL port on the front panel of the 

Epsilon EClipse™ and the CELL port on the rear panel of the Cell Stand. 

3. For instructions on using the C3 and CGME cell stand capabilities within the software, please 

see section 7.2 and 

section 7.4. 

 
5.2. RDE-2 ROTATING DISK ELECTRODE 

The rotation and purging functions of the RDE-2 Rotating Disk Electrode can be controlled from the Epsilon 

EClipse™. 

1. Connect the RDE-2 to the Epsilon EClipse™ using the 37-pin ribbon cable provided with the 

RDE-2 between the ACCESSORIES port on the front panel of the Epsilon EClipse™ and the 

ACCESSORIES port on the rear panel of the RDE-2. 

2. Connect the DIN-LEMO cable (ER-9862) between the CELL port on the front panel of the 

Epsilon EClipse™ and the CELL port on the rear panel of the RDE-2. 

3. For instructions on using the RDE-2 capabilities within the software, please see section 7.2 

and section 7.4. 
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6. UPGRADING THE EPSILON ECLIPSE™ 

Please contact BASi if you wish to upgrade your techniques package, or if you wish to upgrade your single-channel 

instrument to a bipotentiostat. 

 
More information can be found on the BASi website: 

http://www.basinc.com/products/ec/epsilon/upgrade 

http://www.basinc.com/products/ec/epsilon/upgrade
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7. EPSILON ECLIPSE™ SOFTWARE 
 

7.1. INTRODUCTION 

A detailed description of the available electrochemical techniques and how to perform them using the 

electrochemistry software are provided. These functions can all be accessed from the drop-down menus in the 

software. Some of the functions are also available as icons on the tool bar. The available routes will be noted in 

the appropriate sections. If you are new to the instrument, we recommend conducting the chemical test, a detailed 

step by step guide to an example electrochemistry experiment, after installation to familiarize oneself with the 

basic functions of the Epsilon EClipse™ software. 

 
GENERAL OVERVIEW 

The Epsilon EClipse™ software runs in the Windows operating system. It is compatible with Microsoft Windows 7 

and above. It is important to note there are a number of different configurations for the Epsilon EClipse™, which 

differ in their capabilities. It is clearly shown in the text of this manual whether a function or electrochemical 

technique is included as standard on Epsilon EClipse™ instrument, or whether it is only available as an optional 

addition. All optional additions that are inaccessible will be labeled DEMO. 

 
STARTING THE SOFTWARE 

After installing the software, it can be opened by double-clicking on the icon on the desktop. The software should 

automatically connect with the instrument. If it fails to connect automatically or the connection is lost, select 

reconnect epsilon in the instrument menu. 

 

 
7.2. INSTRUMENT MENU 

The Instrument menu allows various settings and controls to be changed on the connected Epsilon EClipse™. Some 

of these options are only available while a technique is open. 

 
MEASURE OPEN CIRCUIT POTENTIAL 

This menu option allows a continuously updating measurement of the open circuit potential at the W1 electrode. 

Please be aware that the cell is on during this measurement and should not be disconnected or adjusted until the 

measurement is terminated by clicking the Done button. 

 
MEASURE IR COMPENSATION 

This menu option is only available while an applicable technique is open. This measurement is not applicable for 

galvanostatic, open circuit potential, or multi-channel techniques. If the menu option is grayed out, click the 

mouse in the graphing portion of the open technique window to activate the command. 

 
Selecting this menu option will activate the IR Comp Measurement section of the open technique. Please 

be aware that the cell is on during this measurement and should not be disconnected or adjusted until the 

measurement is complete. Before selecting this menu item, you have the option to change the Test Potential 

(mV) in the technique parameters. 
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RECONNECT EPSILON 

If at any time the Epsilon EClipse™ becomes unconnected, you can use this menu option to reconnect the 

instrument. 

 
SETUP 

 

 
 

Line Frequency 

This selects the frequency of the line supply, which is used to calculate the time required for one of the current 

sampling options in pulse and square wave experiments. Measuring the current over one line cycle is important for 

noise minimization. 

 
Default Display Type 

This selects the default display type, Polarographic or IUPAC. See section 7.8 for more information. 

 
Cell Stands/Accessories 

The correct option must be selected to control the various Cell Stand operations from the software (i.e., purge and 

stir for the C3; purge, stir, and knock/dispense for the CGME; and purge and rotate for the RDE-2). Before the cell 

stand can be selected, the Cell Stand must be switched on and connect to the Epsilon EClipse™ as described in 

section 5. 
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MANUAL CONTROL 

 

 
Purge/Stir/RDE-2 

The purging and stirring functions of BASi Cell Stands can be switched on and off from this dialog box. If one of 

these functions is enabled, the time for which this function is active must also be entered. The Stop button is used 

to stop this function before the specified time. The appropriate Cell Stand from Cell Stand/Accessories (see above 

Setup information) must be selected in order to ensure proper activation of these functions. In the case of the 

RDE-2, the time entered in the Stir/Rotate field refers to rotation of the electrode. 

 
Back Panel Event On/Off 

These activate the back-panel Timed Event relays (see section 3). 

 
Current Cell Status 

This option specified whether the electrochemical cell is actively connected (Cell On is checked) to the instrument 

at that moment. The default condition is that it is disconnected (Cell On is not checked). This is the safest option, 

since manipulation of the cell lead connections while the cell is connected can cause harm to the user and sever 

damage to the instrument. If Cell On is checked, the potential applied to the cell must also be specified (@ 

Potential (mV)). The potential may be applied in either of the two ranges the instrument is capable of producing, 

±3.257V or ±10V. The Current Cell Status will be maintained until an experiment is run. During an experiment, 

the cell is obviously connected; the cell connection at the end of the experiment is defined in the technique 

parameters (see section 7.4). 

 
External E and I 

These activate the back-panel Timed Event relays (see section 3). 
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7.3. SELECTING A TECHNIQUE 

A number of different electrochemical techniques are available in the Epsilon EClipse™ software, depending upon 

the version. For example, the most basic version has cyclic voltammetry (CV), linear sweep voltammetry (LSV), 

chronoamperometry (CA), controlled 

potential electrolysis (CPE), DC potential amperometry (DCPA), open circuit potential vs. time (OP), and 

chronopotentiometry (CP). The basic plus version of the software includes sampled current polarography (SCP), 

normal pulse voltammetry (NP), differential pule voltammetry (DPV), square wave voltammetry (SWV), and stripping 

voltammetry. The methods software enables the preparation of sequential techniques. An unlimited number of 

techniques can be prepared sequentially. These techniques have different applications, which will be discussed in 

detail in other sections. There are two ways to select a technique: 

 
OPEN 

Selecting Open from the File menu will generate a standard Windows file dialog box, from which a previously saved 

technique file can be loaded. Techniques created in the Epsilon EClipse™ software will have the .etech extension. 

Legacy technique files (created in the old Epsilon software) can also be opened. You have the option to select 

the specific file type extension, or you can view all file types. Other possible file type extensions for the Epsilon 

EClipse™ software include .edata for data and .eseq for sequences. 

 

 
 

 

Opening a File 

 
When opening a file, all stored technique parameters are available on the right side of the graph (Fig2). Upon 

opening a legacy file, the experimental data is displayed. The technique windows can be dragged to a different 

position within the main window. Multiple windows can be tiled vertically, horizontally, or cascaded using the 

appropriate options in the Window menu. 
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Opened Experimental Window 

 
All files can also be selected from any folder on the computer and dragged into the software window. This allows 

for instant opening of many files. 

 
NEW 

Selecting New from the File menu or the New icon will generate a menu that lists the available techniques. Select 

the desired technique and the technique parameter window will appear. 
 

 
Technique List 
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Note that the internal dummy cells options 

are not available for Controlled Potential 

Electrolysis (CPE), Chronopotentiometry (CP), 

or Double Step Chronopotentiometry (DSCP). 

 

Note that the PRE RUN DROPS are not 

available for Controlled Potential 

Electrolysis (CPE). 

A new technique can be opened by selecting New in the File menu. It should be noted that there are some 

techniques that are labeled as DEMO. This label indicates that this technique is NOT active on this particular 

Epsilon EClipse™. However, it is possible to load a data file for that technique to examine the parameters and the 

typical output. If the RUN button is clicked when a DEMO data file is displayed in the active window, an error 

message will be shown. Highlight the required technique, and click OK to confirm the selection. 

 
A previously saved technique can be opened by selecting Open in the file menu. All previously saved techniques 

will have the .etech file extension. If a second file is initiated, the data for this experiment is displayed in a 

separate window. The experimental windows can be dragged to a different position within the main window. 

Multiple windows can be tiled vertically, horizontally, or cascaded using the appropriate options in the Window 

menu. 

7.4. EDITING TECHNIQUES 

CELL SETTINGS 

Cell Selection 

This function allows the user to select between the external W1 Cell Lead connection (required for running an 

experiment on an electrochemical cell) or an internal dummy cell (for troubleshooting). Two choices are available 

for the internal dummy cell – a 10k or a 10M resistor. When the C3 Cell Stand, CGME SDME Mode, or RDE-2 are 

selected, the external W1 Cell Lead is also active by default. 
 

 

CGME SDME Mode 

This option is available when the Cell Selection is set to CGME SDME Mode. This mode should be used with 

the BASi CGME cell stand for polarography and stripping experiments. It can also be used with voltammetry 

experiments using a single mercury drop for the entire experiment. Both the number of drops before the experiment 

(Pre Run Drops) and the drop knock operation (Knock) can be specified in this section. For most potentiostatic 

experiments, the Pre Run Drops are formed with the cell on at the Initial Potential (for stripping experiments, 

they are formed at the Deposition Potential). 
 

 

RDE-2 Settings 

This option is available when the Cell Selection is set to RDE-2. This mode is used to Enable Rotation during 

the technique at the specified RPM (0 or 50-10,000). This mode can also be used with stripping voltammetry 

experiments. 
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EXPERIMENTAL CONDITIONS 

This section of the technique allows the user to enter a number of useful parameters to describe the 

electrochemical cell (e.g. solvent, electrodes, etc.). This information is saved along with the data and other 

experimental parameters. 

 
For convenience, the large assortment of BASi electrodes can be chosen from a list and will automatically populate 

the applicable electrode information. 

 
DEPOSITION 

These parameters are only available for stripping voltammetry techniques (LSSV, SWSV, and DPSV). Please find more 

detailed information on these parameters in section 7.5. 

 
START CONDITIONS 

This parameter determines how the technique starts. If the Immediate option is selected, the technique will begin 

as soon as the user runs the technique through the software. If External Input is selected, the experiment is 

started from an external device using the Start In backpanel connection (see section 3). 

 
Some techniques (CV, LSV, CA, MCCV, MCCA, and all pulse techniques) have the option to specify whether Initial 

E = Open Circuit Potential. If this parameter is enabled, then the open circuit potential will automatically be 

measured and used as the initial potential. These techniques, plus all stripping techniques, also allow a Quiet 

Time (s) to be set. When the experiment is started, this causes the cell to be held at the initial potential for the 

number of seconds defined by this field. 

 
TECHNIQUE PARAMETERS 

The options available in the Technique Parameters section will vary based on which technique is selected. Some of 

the common parameters are discussed in the following section. For more detailed information on technique-specific 

parameters, please see section 7.5. 

 
Applied Potential 

For most techniques, the W1 Applied Potential can be set within two ranges: ±3,275mV or ±10,000mV. The amount 

and variety of applied potential settings will vary based on which technique is selected. 

 
For bipotentiostat techniques, the W2 Applied Potential is limited to the range ±2,550mV. 

 
Please note that when using the Epsilon EClipse™ software on older Epsilon instruments, the ±10,000mV range will 

not be available. 

 
For some of the techniques, the applied waveform will be shown in the graph to the left of the Technique 

Parameters. This allows for confirmation that the parameters entered generate the expected waveform. 
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Scan Rate 

The Scan Rate parameter defines the rate of the applied sweep potential for CV, LSV, and MCCV techniques. The 

digital waveform generator approximates a linear waveform with a staircase waveform with 100µV steps (with 

±3.275V range) or 1/3mV steps (with ±10V range). Since the waveform is generated digitally, only discrete scan 

rates are allowed. The allowable scan rates are given by the equations where n is an integer. Thus, if a scan rate is 

entered that does not match the allowed values, the software will automatically change it to the nearest allowed 

value. The maximum scan rate allowed is 10,000mV/s. 

 

 
 

Current Range 

There are two gain stages for the current-to-voltage converter. The default values of these stages that are used for 

a given Full Scale Current (+/-) are determined by the software. However, they can be adjusted manually using 

the Current Range Stage 1 and Current Gain Stage 2 parameters. 

 
When set manually, the two gain stages for the current-to-voltage converter control the Full Scale Current (+/-). 

The first stage has values in decades from 100nA to 10mA, whereas the second stage is a multiplier with values of 

1, 0.1, and 0.01; that is, the lowest full scale is 1nA. There is more than one combination for intermediate values 

of the full scale, and the default values selected by the software are suitable for most applications. 

 
Noise Filter 

Analog filtering is used to remove noise from the experimental data. The filtering in the Epsilon EClipse™ consists 

of a two-pole Bessel filter. The amount of filtering (the cut-off frequency of the filter) must be selected with 

care, since overfiltering can distort the experimental data. The correct filter frequency depends on the time 

scale of the experiment, and is selected by the software to be at least 10 times larger than the time scale of the 

electrochemical experiment. Although an alternative filter can be selected manually, it is generally best to use the 

default filter. 

 
Number of Runs 

With the exception of galvanostatic and Open Circuit Potential techniques, a technique can automatically run the 

identical experiment repeatedly for a specified number of times. The number of times to repeat is entered in the 

Number of Runs field. 

 
When Number of Runs is greater than 1, the End Cell State section will contain additional fields. The time 

between experiments is defined through Delay Between Runs (s) (2-3600s). Purging and/or stirring will be 

activated between the experiments if Purge During Delay and/or Stir During Delay are enabled. 

 
All data collected during the multi-runs can be displayed and saved in a single data file. To view data from each 

individual run, double-click on the left or right sides of the graph to cycle through the data. 

 
IR COMPENSATION 

For additional information regarding Compensation and when it should be used, please see Section 7.2. Please 

note that iR Compensation is not available for galvanostatic techniques, open circuit potential, or multi-channel 

techniques. 

 
The applied potential between two electrodes in electrochemical experiments does not account for the solution 
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resistance, which causes iR drop between the two electrodes. This resistance can be lowered by the addition 

of supporting electrolyte, and if the solution is sufficiently conductive does not need to be considered. If it is 

detrimental to the experiment, then it can be compensated for electronically. This is achieved on the Epsilon 

EClipse™ using positive feedback iR compensation. 

 
One problem with positive feedback iR compensation is determining the amount of compensation to use, since 

too much feedback can drive the electronics into oscillation, which can have a deleterious effect on both the 

electronics and the electrodes. The automatic iR compensation option on the Epsilon EClipse™ prevents this by 

first measuring the uncompensated solution resistance, followed by incremental compensation and circuit stability 

testing. These features are described below. 

 
MEASUREMENT OF UNCOMPENSATED RESISTANCE 

 
 

 
In this measurement, the electrochemical cell is considered to be electronically equivalent to the RC circuit shown 

above; that is, the uncompensated resistance (RU) is in series with the double-layer capacitance (Cdl). Since 

faradaic impedance is not conserved as part of this model, the test potential must be at a value at which no 

faradaic process occurs. A potential step is applied at this potential and the current is sampled at set points after 

the step is applied. The current decays exponentially (see graph below), and the initial current (I0) is calculated by 

extrapolating back to zero time. Since E = I0RU, RU can be calculated from this measurement. To reduce any error, 

this measurement is performed multiple times, and the results averaged. 

 
 

 

 
COMPENSATION AND CIRCUIT STABILITY TESTING 

Compensation is achieved by positive feedback into the potentiostat. However, problems due to circuit instability 

can arise, even when the degree of compensation is significantly less than 100%. Therefore, the amount of positive 

feedback is increased incrementally, and the stability of the circuit is tested after each increment. The amount of 

positive feedback is increased until the (user-specified) % value is obtained (default = 100%), or the system does 

not pass the stability test. 
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In the stability test, the current following a potential step at the Test potential is again measured. As the percent 

compensation increases, the current response initially shows a “ringing effect”, which is a precursor to oscillation 

(see figure above), and is followed by exponential decay. The degree of pre-oscillation ringing can be quantitated 

by a term defined as overshoot, which the ratio of a minimum (net negative) current value (Imin) to a maximum 

current value (Imax) expressed as a percentage: that is, overshoot = (Imin/Imax) x 100. The maximum allowable 

percentage overshoot is defined by the user (default = 20%). If the percentage overshoot value measured by 

the stability test is less than the maximum allowable value, then compensation is increased. If it is greater, and 

the desired level of compensation has not yet been achieved, a capacitor is inserted between the reference and 

auxiliary electrodes to stabilize the circuit, and the testing is continued until the desired level of compensation is 

achieved or the percentage overshoot value is exceeded (if this occurs, the amount of compensation to be used in 

the experiment is slightly decreased from this value). One way to increase the level of compensation is to increase 

the overshoot percentage. It is usually safe to go up to 40%. 

 
If the desired compensation cannot be obtained using automatic iR Compensation, then a user-specified 

compensation resistance can be applied. If this option is used, then a stabilizing capacitor may also need to be 

selected manually. 

 
Run Technique with IR Comp 

Enables or disables iR Compensation while the technique is running. 

 
Select IR Comp Run Parameters 

The simplest way to use iR Compensation is to enter User Assigned Parameters. However, if the user prefers, 

the software will use the instrument to automatically calculate the compensation (see more information below). 

If User Assigned Parameters is selected, values should be entered for Compensated Resistance (0-100k) and 

Stabilization Capacitor (None, Small, or Large). 

 
IR COMP MEASUREMENT 

When System Measured Parameters is selected from the Select IR Comp Run Parameters drop-down box, the user 

must enter a value for the Test Potential (note that this should be a value at which there is no faradaic reaction). 

 
Select Measure IR Compensation from the Instrument menu to begin the measurement. The following results will 

be filled out under System Measured Parameters upon completion: 

 

• Total Resistance () calculated by the system 

• RC Time Constant (μs) of the cell 

• Uncompensated Resistance () remaining after compensation 

• Compensation (%) percentage to be used in positive feedback 
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WARNING: CAUTION SHOULD BE USED 

IF ANY OF THE CELL ON OPTIONS ARE 

USED, SINCE CONNECTING OR 

DISCONNECTING THE ELECTRODES WHEN 

THE CELL IS ON CAN RESULT IN DAMAGE 

TO THE POTENTIOSTAT, THE CELL, AND/ 

OR THE USER! 

Make sure that Run Technique with IR Comp is set to Enabled to run the experiment with these measured values. 

 
END CELL STATE 

These options specify whether the electrochemical cell remains actively connected at the end of an experiment, 

and, if so, at what potential. The default condition is Cell Off (i.e. the electrochemical cell is not actively 

connected). If the cell is to remain actively connected, the applied potential can be the initial potential (Cell On 

@ Initial Potential) or the final potential (Cell On @ Final Potential) of the experiment. It can also remain 

actively connected at a userspecified potential (Cell On @ Specified Potential) according to the value entered in 

Specified Potential (mV). 

 

Please note that the End Cell State parameters are not available for galvanostatic techniques or open circuit 

potential. 

 
When the Number of Runs is set to a value greater than 1, this section of the parameters will contain additional 

fields for setting the Delay Between Runs (s), Stir During Delay, and Purge During Delay. 
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7.5. AVAILABLE TECHNIQUES 
 

BASIC TECHNIQUES 

Cyclic Voltammetry (CV) 

Cyclic Voltammetry (CV) is one of the most commonly used electrochemical techniques, and is based on a linear 

potential waveform; that is, the potential is changed as a linear function of time. 

 

 
See the figure above for an example CV waveform. The potential range is scanned starting at the Initial Potential. 

At Switching Potential 1, the potential range is scanned again in the reverse direction. The experiment can be 

stopped at the Final Potential, or the potential can be scanned past this potential to Switching Potential 2, 

where the direction of the potential scan is again reversed. The potential can be cycled between the two switching 

potentials for several cycles before the experiment is ended at the Final Potential. (The practical limit on the 

number of segments is based on the maximum 64,000 data points that can be collected during an experiment.) 

The Scan Rate defines the rate of change of the potential with time. 

 
Range of allowed parameter values: 

 
• Potential: ±3275mV or ±10V 

• Scan Rate: 1-25000mV/s 

• Quiet Time: 0-100s 

 
 

Cyclic Voltammetry Waveform 

 
The defined waveform will depend upon the number of segments: 

 
• 1 segment: Initial Potential➔Final Potential (equivalent to an LSV experiment) 

• 2 segments: Initial Potential➔Switching Potential 1➔Final Potential 

• 3 segments: Initial Potential➔Switching Potential 1➔Switching Potential 2➔Final Potential 

(setting Final Potential equal to Initial Potential will generate a complete potential cycle) 

• 4 segments: Initial Potential➔Switching Potential 1➔Switching Potential 2➔Switching 

Potential 1➔Final Potential 
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Additional segments can be added beyond 4, but those segments will be repetitions of those four settings. The 

practical limit on the number of segments is based on the maximum 64,000 data points that can be collected 

during an experiment. The Scan Rate defines the rate of change of the potential with time. 

 
The CV default plot is current vs. potential plot (I vs E). Other plot types can be selected by right-clicking on the 

graph and selecting I vs t (current vs. time), E vs t (potential vs. time, i.e. the applied waveform), and the derived 

graphs Semi Int and Semi Diff. 

 
Analysis 

The asymmetric shape of the current vs. voltage CV plot is due to diffusional mass transport. However, there are 

many other parameters that can affect the shape of this curve; for example, slow heterogeneous transfer kinetics, 

instability of the oxidized or reduced species, and adsorption. If the heterogeneous electron transfer is rapid 

(relative to the timescale of the experiment) and both the oxidized and reduced species are stable, then the redox 

process is described as electrochemically reversible. The standard redox potential is the mean of the cathodic and 

anodic peak potentials and the peak separation is 59.2/n mV (n = number of electrons transferred per molecule) at 

all scan rates. 

 

 
A typical cyclic voltammogram showing the important parameters using 2 mM potassium ferricyanide and 1 M 

potassium nitrate in deionized water. 

 
The peak current at 25°C is given by the Randles-Sevcik equation: 

 
 

 
where: n = number of electrons transferred/molecule 

A = electrode surface area (cm2) 

C = concentration (mol cm-3) 

D = diffusion coefficient (cm2 s-1) 
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ν = scan rate (V s-1) 

 
This equation demonstrates that the peak current is proportional to the concentration and the square root of the 

scan rate. Departures from reversible behavior for a redox process are shown by variations of the above parameters 

from the values observed for reversible processes. There are two major causes for irreversible behavior and these 

are discussed below. 

 
SLOW ELECTRON TRANSFER KINETICS 

Reversibility requires that the electron transfer kinetics are fast enough to maintain the surface concentrations of 

O and R at the values required by the Nernst equation. Hence, reversibility depends on the relative values of the 

standard heterogeneous electron transfer rate constant (k
s
) and the rate of change of potential - the scan rate ν. If 

the ratio of k
s
/ν is sufficiently small that Nernstian concentrations cannot be maintained, then the process is said 

to be quasi-reversible. A quasi-reversible process is characterized by ΔE
p 

> 59.2/n mV, with the value increasing 

with increasing ν. 

 

Since reversibility depends on the value of k
s
/ν, it may be possible to change a process from quasi-reversible to 

reversible by decreasing ν (which allows more time for the surface concentrations to adjust to the new values 

required by the changing potential). In addition, ΔEp depends on the value of k
s
/ν, and ks can therefore be 

calculated from the variation of ΔEp with ν. 

 

Unfortunately, increases in ΔE
p 

with increasing n can also be due to uncompensated solution resistance R
u
. The 

effect of R
u 

can be minimized by careful experimental design, electronic positive feedback compensation and post- 

run data manipulation. The two effects can be distinguished by varying the analyte concentration (the potential 

drop due to uncompensated solution resistance, and hence the resulting ΔEp, increase with increasing current, 

whereas k
s 

is independent of analyte concentration). 

 
CHEMICAL REACTIONS OF O AND R 

Equilibrium values of O and R can only be maintained during a cyclic voltammetry experiment if both O and R are 

stable on the experimental time scale. For example, if the reduction of O to R is followed by the conversion of R 

to P, then more R must be generated to compensate for the loss of R. Therefore, the rate of reduction increases 

and E
pc 

moves to a more positive value. In addition, i
pa
/i

pc 
is less than unity (since only a fraction of the molecules 

that were reduced on the forward scan are available for reoxidation on the reverse scan). The value of the current 

function can also be affected by chemical reactions following electron transfer. 

 
The effect of a chemical reaction depends on the value of the ratio k/ν (where k is the rate of the chemical 

reaction). If this value is large, then the chemical reaction has a significant effect, whereas any effect is much 

less if this ratio is small. Therefore, it may be possible to eliminate the effect of the chemical reaction (thereby 

restoring reversibility) by increasing ν. k can be calculated either by simulation studies or by investigating the 

effect of ν on i
pa
/i

pc
. 

Although cyclic voltammetry is very widely used for the initial redox characterization of a molecule (i.e., the 

redox potentials, and the stability of the different oxidations states) and for qualitative investigation of chemical 

reactions that accompany electron transfer, there are a number of disadvantages inherent in this technique: 

a. The effects of slow heterogeneous electron transfer and chemical reactions cannot be separated. 

If both of these effects are present, then the rate constants for these processes can only be 

calculated using simulation methods. 

b. There is a background charging current throughout the experiment of magnitude νC
dl 

(where C
dl 

is the capacitance of the interface at the working electrode). This restricts the detection limit to 
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about 10-5 M. In addition, the ratio of the peak faradaic current to the charging current decreases 

with increasing ν (since ip is proportional to ν1/2), and this places an upper limit on the value 

of n that can be used. 

 
In spite of these limitations, cyclic voltammetry is very well suited for a wide range of applications. Indeed, in 

some areas of research, cyclic voltammetry is one of the standard techniques used for characterization. 

 
DERIVED GRAPHS 

The default plot for LSV and CV is the current vs. potential plot. However, two other plots are available: 

SemiIntegration and SemiDifferentiation (see images below). These are mathematical transforms of the basic 

current vs. potential plot. 

 

 
A typical cyclic voltammogram following SemiIntegration using 2 mM potassium ferricyanide and 1 M 

potassium nitrate in deionized water. 

 

 

 

A typical cyclic voltammogram following SemiDifferentiation using 2 mM potassium ferricyanide and 1 M 

potassium nitrate in deionized water. 
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Linear Sweep Voltammetry (LSV) 

Linear Sweep Voltammetry (LSV) is a simplified form of CV. This technique is equivalent to a CV technique 

consisting of a single segment. For LSV, only the Initial Potential, Final Potential, and Scan Rate are required to 

build the applied waveform. 

 
Range of allowed parameter values: 

• Potential: ±3275mV or ±10V 

• Scan Rate: 1-10000mV/s 

• Quiet Time: 0-100s 

 

 
A typical linear sweep voltammogram showing the important parameters using 2 mM potassium ferricyanide 

and 1 M potassium nitrate in deionized water. 

 
Chronoamperometry/Chronocoulometry (CA) 

Chronoamperometry (CA) and Chronocoulometry (CC) have the same potential waveform – the potential step – 

which is one of the simplest potential wave forms. 

 

See the figure above for an example waveform. The potential is changed instantaneously from the Initial Potential 

to the First Step Potential, and it is held at this value for the First Step Time. This is a single potential step 

experiment. In a double potential step experiment, the potential is changed to the Second Step Potential after 

the First Step Time, and it is then held at this value for the Second Step Time. In CA, the current is monitored as a 
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function of time, whereas in CC, the charge is monitored as a function of time. It is important to note that the basic 

potential step experiment on the Epsilon EClipse™ is CA; that is, during the experiment, the current is recorded as a 

function of time. However, after the experiment, the data can also be displayed as charge as a function of time (the 

charge is calculated by integrating the current). Hence, chronocoulometry data can be obtained. 

 
CA is different from other constant potential techniques (such as CPE and DCPA) in that the time scale of CA is 

shorter (milliseconds and seconds) than those of CPE and DCPA (seconds and minutes). 

 
Range of allowed parameter values: 

 
• Potential: ±3275mV or ±10V 

• Quiet Time: 0-100s 

• Step Time: 1-65s or 1-16000ms 

• Maximum # of points in a step: 1000, 2000, 4000, 8000, 16000 

The Sample Interval is determined by those parameters, and can only be adjusted by the user indirectly. The 

relationship between these parameters is shown by the equation 

 
Sample Interval = Step Time / Maximum # of Points 

 
However, it should be noted that only certain values are allowed for each of these parameters, as is shown in the 

table below: 

 

 
The default plot for CA is the current vs. time plot (I vs t). The plot for CC can be displayed by right-clicking on 

the graph and selecting Q vs t in the Derived Graphs menu. This plot is calculated by the software by integrating 

the I vs t plot. Derived graphs Q vs sqrt(t) and I vs 1/sqrt(t) can also be displayed. 

 
Analysis 

The current/charge response depends on the values of the initial and final potentials. If no Faradaic reaction occurs 

at either potential (a Faradaic reaction is the electrolysis of any molecules in solution), then the response is due 

to charging of the electrode (the charging or background current). The response is a current ‘spike’, which decays 

exponentially, shown below. Often, the initial potential is a potential at which no Faradaic reaction occurs, and the 

final potential is a potential at which the Faradaic reaction occurs very rapidly. Thus, the electroactive molecules are 

electrolyzed as soon as they arrive at the surface of the working electrode. Therefore, the current is determined by 

the rate of mass transport from the bulk solution to the working electrode surface; the rate of diffusion. 
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Current-time response for a double-potential step chronoamperometry experiment using 2 mM potassium 

ferricyanide and 1 M potassium nitrate in deionized water. 

 
Diffusion controlled is described by the Cottrell equation: 

 
i=nFACD 1/2 π –1/2 t –1/2 

 
where: n = number of electrons transferred/molecule 

F = Faraday’s constant (96,500 C mol-1) 

A = electrode area (cm2) 

D = diffusion coefficient (cm2s-1) 

C = concentration (mol cm-3) 

t = time (s) 

 
This indicates that, under these conditions, there is a linear relationship between the current and the 1/square 

root of time. A plot of i vs. t-½ is often referred to as the Cottrell plot, shown below. 

 

Cottrell plot for a chronoamperometry experiment using 2 mM potassium ferricyanide and 1 M potassium 

nitrate in deionized water. 
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The analysis of chronocoulometry (CC) data is based on the Anson equation, which defines the charge-time 

dependence for linear diffusion control: 

 
Q=2nFACD 1/2 π –1/2 t 1/2 

 
The charge-time (Q-t) (the Anson equation) is obtained by integrating the Cottrell equation with respect to time. 

A typical charge-time plot is shown below. 

 
 

 

Charge-time response for a double-potential step chronocoulometry/chronoamperometry experiment using 2 

mM potassium ferricyanide and 1 M potassium nitrate in deionized water. 

 
Charge is the integral of current, so the response for CC increases with time, whereas that for CA decreases. Since 

the latter parts of the signal response must be used for data analysis (the finite rise time of the potentiostat 

invalidates the early time points), the larger signal response at the latter parts for CC makes this the more 

favorable potential step technique for many applications (in addition, integration decreases the noise level). 

 
 

 
Anson plot for a chronocoulometry experiment 
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diff ads dl 0 dl 

The slope and intercept of the Cottrell and Anson plots can be measured by the Epsilon EClipse™ software. Since 

the slope of the Cottrell and Anson plots are determined by n, A, D, and C, one of these parameters can be 

calculated from the slope, provided the other three are known. The electrode surface area (A) and the diffusion 

coefficient (D) are frequently calculated with this technique. 

 
It is important to note that in any potential step experiment, there is a delay in attaining the step potential due 

to the finite rise time of the potentiostat. This non-ideal behavior affects the validity of the data points measured 

during this delay time, and hence these data are discarded when calculating the slope and intercept (the default 

condition for the Epsilon EClipse™ software is that the final 80 % of data points are used). The non-linearity of 

the early data points is most clearly shown in the Cottrell plot, due to the reciprocal time function (i.e., early data 

points = large x). In contrast, the non-linearity is much less pronounced in the Anson plot. 

 
Double potential step techniques can be used to investigate the kinetics of chemical reactions following electron 

transfer. As discussed elsewhere, only a fraction of the molecules of O that are formed as a result of the first 

potential step are reduced again during the second step. Therefore, the current or charge due to the second step 

(i
r 
or Q

r
) is less than that due to the first step (i

f 
or Q

f
). If O undergoes a chemical reaction to a molecule that 

is not reduced after the second step, then even fewer molecules of O are available for reduction, and ir and Qr 

show a corresponding decrease. The rate of the chemical reaction (k) can be calculated by investigating the effect 

of changing the Step Time on the i
r
/i

f 
(or Q

r
/Q

f
) ratio and comparing these values to published working curves. 

Although working curves are available for both i
r
/i

f 
and Q

r
/Q

f
, CC is generally more favored due to the better signal 

to noise ratio. 

 
One of the major applications of CC is the study of species adsorbed to the surface of the working electrode 

(indeed, it was originally devised for such studies). The advantage of using CC rather than CA is that it is possible 

to separate the charge due to the electrolysis of the adsorbed molecules from the charge due to the electrolysis of 

molecules in solution and the double layer charge (the analogous separation of currents is generally not possible). 

This is achieved using the Anson plot. 

 
As discussed above, the electrolysis of solution species is diffusion-controlled, and depends on t½. In contrast, the 

electrolysis of adsorbed species and double layer charging is essentially instantaneous. The equation for the total 

charge Q is shown below. 

 
Q=Q +Q  +Q or  Q=2nFACD 1/2 π -1/2 t 1/2 +nFAΓ +Q 

 
where: Q

diff 
= charge due to electrolysis of solution species 

Q
ads 

= charge due to electrolysis of adsorbed species 

Q
dl 

= double-layer charging 

Γ
0 
= surface concentration of adsorbed species (mol cm-2) 

Therefore, the intercept of the Anson plot is the sum of Q
dl 

and Q
ads

. One method for eliminating Q
dl 

from the 

equation is to run the identical experiment on the electrolyte alone. However, this approach assumes that Q
dl 

is the 

same both in the presence and in the absence of the adsorbed analyte, which is generally not a valid assumption. 

The alternative method is to use the double potential step experiment. If only one of O and R adsorbs, then Q
ads 

is 

the difference of the intercepts of the Anson plots for the two steps. 

 
It is important to note that data from the later time domains of the experiment are being used to investigate 

behavior that occurred at early time points. This shows that integration retains information about electrolysis 

that occurs essentially simultaneously with the potential step. This is a major advantage of CC, since direct 

measurement of such behavior is generally very difficult. 
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In all the above applications, the initial potential is at a value at which electrolysis does not occur, and the step 

potential is at a value at which electrolysis occurs at a diffusion-controlled rate (the second step is generally 

from the step potential back to the initial potential). Therefore, before these potentials can be determined, the 

redox potential must first be known. In general, the simplest way to find these potentials is to record the cyclic 

voltammogram of the analyte. 

 
Controlled Potential Electrolysis (CPE) 

The principle behind the Controlled Potential Electrolysis (CPE) experiment is very simple. If only the oxidized 

species is initially present, then the potential is set at a constant value sufficiently negative to cause rapid 

reduction and is maintained at this value only until the reduced species is present in solution. The total charge 

passed during the CPE experiment (Q) is calculated by integrating the current and is related to the number of 

electrons transferred per molecule (n) and the number of moles of the oxidized species initially present (N) 

through Faraday’s law: 

 
Q = nFN 

 
where F is Faraday’s constant (96500 C mol-1). Therefore, if one of n or N is known, the other can be calculated. 

Hence, CPE has both analytical and synthetic applications. 

 
A Stabilization Capacitor between the auxiliary and reference electrodes is switched in during the CPE 

experiment. The capacitor can be set to Large (0.1µF), Small (0.01µF), or None. 

 
The End Condition of the CPE experiment can be set by the user in a number of ways. The most basic criterion is 

the Time Limit, which must be set by the user; that is, the experiment will end after a user-defined time period 

(select Time Limit Only for the end condition). However, there are three optional criteria that can also be set: 

 
• Charge Limit: the absolute value of the charge limit should be specified 

• Minimum Current Limit: the absolute minimum current value should be specified 

• Current/Initial Current Ratio: the criterion is the ratio of the final current to the initial current in 

parts per thousand 

 
Any single one of these optional criteria can be used in addition to the time limit. However, it is important to 

note that the time limit always takes precedence; that is, if the time limit is attained before, for example, the 

charge exceeds the charge limit, the experiment will end. It should also be noted that there will typically be a 

delay of 1 or 2 seconds between the time the selected criterion is exceeded and the termination of the experiment, 

due to the time required for data processing. If any of these optional criteria are used, the multi-run capability is 

disabled. 

 
Range of allowed parameter values: 

 
• Potential: ±3275mV or ±10V 

• Sample Interval: 0.05, 0.1, 0.2, 0.5, 1, 2, 5, 10, 30, or 60s 

• Time Limit: 0-32000 in seconds or minutes (see below) 

 
The maximum value for the Time Limit is also determined by the Sample Interval, since a maximum of 64000 

data points can be recorded in one experiment. 

 
The output from a CPE technique is a current vs. time plot. The charge vs. time plot can be displayed by right- 

clicking on the graph and selecting Q vs t in the Derived Graphs menu. 



BASi | Epsilon EClipse PART 7 | EPSILON ECLIPSE SOFTWARE 

46 

 

 

Analysis 

The potential required for a CPE experiment is determined by the redox potential of the analyte (e.g measured by 

cyclic voltammetry). For a reduction, the ideal potential is ca. 200 mV more negative than the redox potential so 

that the rate of electrolysis is controlled by the rate of mass transport to the working electrode. However, it is 

not always possible to use a potential too far from the redox potential due to electrolysis of other electroactive 

materials (i.e. electrolyte, solvent, or other components of the solution mixture). 

 
The cell required for CPE is significantly different to that required for voltammetry experiments (in which only a 

very small fraction of the electroactive molecule of interest is electrolyzed). The rate of electrolysis is enhanced by 

using a working electrode with a large surface area (i.e. platinum gauze, reticulated vitreous carbon or a mercury 

pool) and an auxiliary electrode with a large surface area (i.e. platinum coil or gauze); in addition, the solution is 

stirred to increase the rate of mass transport to and from the working electrode. The auxiliary electrode must be 

isolated from the working electrode to prevent species that are electrogenerated at the auxiliary electrode from 

interfering with electrolysis at the working electrode. However, care must be taken when choosing the material 

used to isolate the auxiliary electrode from the working electrode, since high resistance material may affect the 

efficiency of the electrolysis. The output from a CPE experiment is a current vs. time plot is shown below. 

 

 
Current vs. time plot for constant potential electrolysis using 0.5 mM potassium ferricyanide and 1 M 

potassium nitrate in deionized water with an applied potential of 0.0 V vs. Ag/AgCl and a 400 rpm stir rate. 

 
Net Charge is calculated by subtracting the background charge from the total charge passed during the experiment 

(Charge). The background current is assumed to be constant during the experiment, and equal to End I. Therefore, 

the background charge is equal to the product of the background current and the experimental time. Once the 

Net Charge has been calculated, it can be used to calculate the number of electrons transferred or the amount of 

material electrolyzed (in moles) through Faraday’s Law: 

 
Q = nFN 

 
n = number of electrons transferred/molecule 

F = Faraday’s constant (96,500 C mol-1) 

N = amount of material electrolyzed (mol) 
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DC Potential Amperometry (DCPA) 

DC Potential Amperometry (DCPA) is the simplest technique on the Epsilon EClipse™. A constant potential is 

applied to the electrochemical cell, and the current response is monitored. Typical applications of this technique 

include amperometric titrations, amperometric sensors, flow cells (including liquid chromatography with 

electrochemical detection), etc. 

 
The DCPA experiment can be run on a hanging mercury drop electrode (i.e. a single drop is used for the entire 

experiment) using a BASi CGME by selecting CGME SDME Mode in the Cell Selection box. A rotating disc 

experiment can be run using a BASi RDE-2 by selecting RDE-2 in the Cell Selection box, and entering the require 

RPM (please note that the CGME and/or the RDE-2 must be selected in the Instrument menu by going to Setup). 

 
The end of the DCPA experiment is determined by the Time Limit, although the experiment can be ended by the 

user before that time. 

 
Range of allowed parameter values: 

 
• Potential: ±3.275V or ±10V 

• Sample Interval: 0.05, 0.1, 0.2, 0.5, 1, 2, 5, 10, 30, or 60s 

• Time Limit: 0-32000 (see below) 

 
The maximum value allowed for Time Limit is also determined by the Sample Interval, since a maximum of 64000 

data points can be recorded in one experiment. 

 
The Applied Potential is determined by the redox potential of the analyte. For example, if DCPA is used for EC 

detection for HPLC, the potential should be such that the analyte is electrolyzed at the mass-transport limited rate 

(as determined by hydrodynamic voltammetry). However, the increase in noise and the decrease in selectivity with 

increasing positive or negative potentials may also need to be considered when selecting the potential value. 

 
Open Circuit Potential vs. Time (OP) 

The Open Circuit Potential (also referred to as the equilibrium potential, the rest potential, or the corrosion 

potential) is the potential at which there is no current; that is, experiments based on the measurement of the 

open circuit potential are potentiometric experiments. Although such measurements are very simple, they have 

many important applications, which are briefly 

discussed below. 

 
Setting up an OP technique is very simple. Please note that the multi-run option is not available for this 

technique. In addition to this measurement, the open circuit potential can be monitored using Measure Open 

Circuit Potential in the Experiment menu. Furthermore, this potential can be measured before another experiment 

(i.e. cyclic voltammetry) and can be automatically used as the initial potential. 

 
The basis of potentiometric concentration measurements (i.e. for potentiometric titrations) is the Nernst equation, 

which relates to the concentration of electroactive species at the electrode surface (CS) to the potential at that 

electrode (E); that is, for the reaction O + e- = R 
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Where EO’ is the formal redox potential of the electron transfer reaction. The potential E is measured between 

two electrodes: the indicator electrode and the reference electrode (the auxiliary electrode is disconnected 

for potentiometric measurements on the epsilon). The indicator electrode is selected such that its potential is 

sensitive to the concentration of the analyte in solution (i.e. a glass membrane electrode for the measurement 

of pH), and the reference electrode (i.e. the saturated calomel or the silver/silver chloride electrode) provides a 

stable reference potential for the measurement of the potential of the indicator electrode. 

 
Other important open circuit potential measurements are the open circuit potential of a battery, and the 

equilibrium (corrosion) potential of a corroding system. 

 
Chronopotentiometry (CP) 

Epsilon EClipse™ instruments contain both a potentiostat and a galvanostat, and hence can perform both 

controlled potential (potentiostatic) and controlled current (galvanostatic) experiments. Although potentiostatic 

experiments are much more common, there are some applications for which a galvanostat is advantageous. 

 
The galvanostat uses a three electrode configuration, in which a current is applied between the auxiliary and 

working electrodes, and the potential of the working electrode (measured with respect to the reference electrode) 

is monitored. The basis of controlled current experiments is that a redox (electron transfer) reaction must occur at 

the surface of the working electrode in order to support the applied current. For example, if ferricyanide is present 

in the solution, then a reducing current will lead to the reduction of ferricyanide to ferrocyanide at the working 

electrode (note that a balancing oxidation must also occur at the auxiliary electrode). Common applications of 

the galvanostat include constant current stripping potentiometry and constant current electrolysis (including 

applications where a constant rate of electrolysis in important, such as electrodeposition and battery studies). One 

advantage of all constant current techniques is that the ohmic drop due to solution resistance is also constant, as 

it is equal to the product of the current and the solution resistance. The ohmic distortion can therefore be simply 

corrected by a constant potential offset. In contrast, in potentiostatic experiments (i.e. cyclic voltammetry), the 

current, and hence the ohmic drop, varies with potential, and correction is more complicated. 

 
 

 

Chronopotentiometry (CP) is the most basic constant current experiment. In CP, a current step is applied across an 

electrochemical cell (without stirring). 

 
Applied Current values are entered in mA, µA, nA, or pA, depending on which Applied Current Range is 

selected. The current polarity is determined by the Applied Current Convention (IUPAC for positive oxidation 
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current, Polarographic for positive reduction current. The end of the experiment can be determined by the Time 

Limit or by the End at Upper Limit/End at Lower Limit selections (range of values depends on which Potential 

Measurement Range is selected). The experiment can also be ended manually. 

 
Range of allowed parameter values: 

 
• Current: 50pA-50mA (see below) 

• End Condition E Limit: ±999mV or ±9999mV (depending on Potential Range selection) 

• Sample Interval: 0.05, 0.1, 0.2, 0.5, 1, 2, 5, 10, 30, or 60s 

• Time: 32000 (see below) 

 
Please note there are accuracy limitations when applying sub-nA currents. The Epsilon EClipse™ typically has a 

background current of about 30pA, and a drift of about 5pA over an 8 hour period. However, it may be possible 

to determine the average background current for a given instrument, and hence “correct” the applied current to 

compensate for the background and drift. 

 
The maximum number of data points that can be collected in one experiment is 64000, so the maximum value for 

the Time of a given experiment is also determined by the Sample Interval. 

 
Analysis 

The shape of the potential response can be rationalized by considering the concentration profiles of the redox 

species as a function of time: 

 
 

 
Concentration profiles for chronopotentiometry 

 
Let us consider the electron transfer reaction O + e- = R. Before the current step, the concentration of O at the 

electrode surface is the same as in the bulk solution (i.e. 5 mM). The initial potential is the rest potential or the 

open circuit potential (E
o.c.

). Once the (reducing) current step has been applied, O is reduced to R at the electrode 

surface in order to support the applied current, and the concentration of O at the electrode surface therefore 

decreases. This sets up a concentration gradient for O between the bulk solution and the electrode surface, and 

molecules of O diffuse down this concentration gradient to the electrode surface. The potential is close to the 

redox potential for O + e- = R, and its precise value depends upon the Nernst equation: 
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where Cs
 and Cs

 are the surface concentrations of O and R, respectively. These concentrations vary with time, 

so the potential also varies with time, which is reflected in the finite slope of the potential vs. time plot at this 

stage. Once the concentration of O at the electrode surface is zero, the applied current can no longer be supported 

by this electron transfer reaction, so the potential changes to the redox potential of another electron transfer 

reaction. If no other analyte has been added to the solution, the second electron transfer reaction will involve 

reduction of the electrolyte; that is, there is a large change in the potential. 

 
 

Typical potential response for a chronopotentiometry experiment 

Double Step Chronopotentiometry (DSCP) 

Double Step Chronopotentiometry (DSCP) is similar to CP; however in this technique a second current step 

is applied. It should also be noted that the time scale of a DSCP experiment is typically shorter (seconds or 

milliseconds) than that of CP (minutes or seconds). The protocol for defining the sampling rate is therefore 

different for the two techniques. 

 

 

Four parameters are used to define the current waveform for DSCP: First Step Current, Second Step Current, 

First Step Time, and Second Step Time. The current values are entered in mA, µA, nA, or pA, depending on which 

Current Range is selected. 

O R 
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Range of allowed parameter values: 

 
Current: 50pA-32mA (see below) 

Step Time: 1-65s or 1-16000ms 

Maximum # of points in a step: 1000, 2000, 4000, 8000, 16000 

Sample Interval: 0.05, 0.1, 0.2, 0.5, 1, 2, 5, 10, 30, or 60s 

Time: 32000 (see below) 

 
Please note there are accuracy limitations when applying sub-nA currents. The Epsilon EClipse™ typically has a 

background current of about 30pA, and a drift of about 5pA over an 8 hour period. However, it may be possible 

to determine the average background current for a given instrument, and hence “correct” the applied current to 

compensate for the background and drift. 

 
The Sample Interval is determined by the Step Time and the Maximum # of points in a step, and can only be 

adjusted by the user indirectly through those parameters. For more details on the Sample Interval limitations, 

please see the section on CA. 

 
BASIC PLUS TECHNIQUES 

A number of different pulse techniques are available in the Basic Plus package for the Epsilon EClipse™, which 

differ in their potential pulse wave forms, the number of sampling points, and whether a solid electrode 

(voltammetry) or a mercury drop electrode (polarography) is used. The discrimination against the charging current 

that is inherent in these techniques leads to lower detection limits (when compared to linear sweep techniques), 

which makes these techniques suitable for quantitative analysis. 

 
The basis of all pulse techniques is the difference in the rate of the decay of the charging and the faradaic currents 

following a potential step (or “pulse”). The charging current decays exponentially, whereas the faradaic current 

(for a diffusion-controlled current) decays as a function of 1/(time)½; that is, the rate of decay of the charging 

current is considerably faster than the decay of the faradaic current. The charging current is negligible at a time of 

5RuCdl after the potential step (RuCdl is the time constant for the electrochemical cell, and ranges from µs to ms). 

Therefore, after this time, the measured current consists solely of the faradaic 

current; that is, measuring the current at the end of a potential pulse allows discrimination between the faradaic 

and charging currents. 

 
The important parameters for pulse techniques are as follows: 

 
1. S.W./Pulse Amplitude is the height of the potential pulse. This may or may not be constant depending 

upon the technique. 

2. Pulse/Step Width is the duration of the potential pulse. 

3. Sample Period is the time at the end of the pulse during which the current is measured. 

4. For some pulse techniques, the Pulse Period or Drop Time must also be specified. This parameter 

defines the time required for one potential cycle, and is particularly significant for polarography (i.e. 

pulse experiments using a mercury drop electrode), where this time corresponds to the lifetime of each 

drop (i.e. a new drop is dispensed at the start of the drop time, and is knocked off once the current has 

been measured at the end of the drop time - note that the end of the drop time coincides with the end 

of the pulse width). 

 
In each pulse technique, the Pulse Type must be specified when using a mercury electrode (CGME SMDE Mode). If 

Voltammetry is selected, the whole experiment is performed on a single mercury drop (after the Pre Run Drops). 

If Polarography is selected, a new drop is used for each data point. 
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Three options are available for Sample Period: 

• 1 Point: The current is measured once at the end of the Step/Pulse Width. 

• 1 ms: The current is measured multiple times in 1ms at the end of the Step/Pulse Width. 

• 1 Line Period: The current is measured multiple times over 1 line cycle at the end of the Step/ 

Pulse Width and averaged. The time required for 1 line cycle is the reciprocal of the line fre- 

quency (16.7ms for 60Hz, and 20ms for 50Hz). The line frequency is selected in the Setup under 

the Instrument menu. 

 
Generally speaking, increasing the Sample Period increases the signal-to-noise ratio. However, the 1 Line Period 

option may not be possible for short Step/Pulse Width values. 

 
Sampled Current Polarography 

Sampled current polarography (SCP) is a modification of the classical DC polarography experiment, and was 

designed to reduce the effect of the changing surface area of the mercury drop electrode. The potential wave form 

is shown in below. The potential is varied in a series of steps, with the current sampled at the end of each step. 

 

 

Range of allowed parameter values: 

• Potential: ±3275mV or ±10V 

• Step Potential: 1-40mV 

• Step Width: 100-6550ms (Polarography) or 4-6550ms (Voltammetry) 

• Quiet Time: 0-100s 

 
The scan rate cannot be directly changed by the user, and is determined by Step Potential x 1/Sample Width. 

The current response for SCP is shown below. The limiting current (id) is given by the Ilkovic equation: 

i = 708nCD1/2m2/3t1/6 

 
where: n = number of electrons transferred/molecule 

C = concentration (mol cm-3) 

D = diffusion coefficient (cm2 s-1) 

m = mercury flow rate (mg s-1) 

t = sampling interval (s) 
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A typical sampled current polarogram 

 
Normal Pulse Voltammetry/Polarography (NP) 

The potential waveform for normal pulse voltammetry/polarography (NP) is shown below. The potential waveform 

consists of a series of pulses of increasing amplitude, with the potential returning to the initial value after each 

pulse. 
 

Range of allowed parameter values: 

 
• Potential: ±3275mV or ±10V 

• Step Potential: 1-40mV 

• Step Width: 100-6550ms (Polarography) or 4-6550ms (Voltammetry) 

• Quiet Time: 0-100s 

 
The scan rate cannot be directly changed by the user, and is determined by Step Potential x 1/Pulse Period. The 

Pulse Period must be at least twice the Pulse Width. 

 
Consider a reduction. If the Initial Potential is well positive of the redox potential, theapplication of small 
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amplitude pulses does not cause any faradaic reactions; hence there is nocurrent response. When the pulse 

amplitude is sufficiently large that the pulse potential is close to the redox potential, there is a faradaic reaction 

in response to the potential pulse (assuming moderately fast electron transfer kinetics), and the magnitude of this 

current may depend on both the rate of diffusion and the rate of electron transfer. When the pulsed potentials are 

sufficiently negative of the redox potential that the electron transfer reaction occurs rapidly, the faradaic current 

depends only on the rate of diffusion; that is, a limiting current has been attained. The sigmoidal shape typically 

observed for NP (see below) is similar to the shape of the current-potential curve obtained in the classical 

polarography experiment, which gives rise to the name of “normal” for this technique. 
 

A typical normal pulse voltammogram 

Differential Pulse Voltammetry/Polarography (DP) 

The potential wave form for differential pulse voltammetry/polarography (DP) is shown below. The potential 

wave form consists of small pulses (of constant amplitude) superimposed upon a staircase wave form. Unlike NP, 

the current is sampled twice in each Pulse Period (once before the pulse, and at the end of the pulse), and the 

difference between these two current values is recorded and displayed. 
 

 

Potential wave form for differential pulse voltammetry 
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Range of allowed parameter values: 

 
• Potential: ±3275mV or ±10V 

• Step Potential: 1-40mV 

• Pulse Amplitude: 5-250mV 

• Pulse Width: 3-1000ms 

• Step Width: 100-6550ms (Polarography) or 4-6550ms (Voltammetry) 

• Quiet Time: 0-100s 

 
The scan rate cannot be directly changed by the user, and is determined by Step Potential x 1/Pulse Period. The 

Pulse Period must be at least twice the Pulse Width. 

 
Consider a reduction. At potentials well positive of the redox potential, there is no faradaic reaction in response to 

the pulse, so the difference current is zero. At potential around the redox potential, the difference current reaches 

a maximum, and decreases to zero as the current becomes diffusion-controlled. The current response is therefore a 

symmetric peak (see below). 

 

 

A typical differential pulse voltammogram 

 
Square Wave Voltammetry (SW) 

The potential wave form for square wave voltammetry (SW) is shown below. The potential wave form consists of a 

square wave of constant amplitude superimposed on a staircase wave form. The current is measured at the end of 

each half-cycle, and the current measured on the reverse half-cycle (i
r
) is subtracted from the current measured on 

the forward half-cycle (i
f
). This difference current (i

f 
- i

r
) is displayed as a function of the applied potential. 
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Potential wave form for square wave voltammetry 

The step height of the staircase waveform and the potential resolution is determined by the 1/S.W. Frequency. 

Three options are available for Sample Period: 

• 1 Point: The current is measured once at the end of each half-cycle (maximum S.W. Frequency = 

2000Hz). 

• 1 ms: The current is measured multiple times in 1 ms at the end of each half-cycle and averaged 

(maximum S.W. Frequency = 125Hz). 

• 1 Line Period: The current is measured multiple times over 1 line cycle at the end of the Pulse 

Width and averaged. The time required for 1 line cycle is the reciprocal of the line frequency 

(16.7ms for 60Hz, and 20ms for 50Hz). The line frequency is selected in the Setup under the 

Instrument menu. 

 
The experiment can be run on a hanging mercury drop electrode (i.e. a single drop is used for the entire 

experiment) using a BASi CGME by selecting CGME SDME Mode in the Cell Selection box. 

 
Range of allowed parameter values: 

• Potential: ±3275mV or ±10V 

• Step Potential: 1-40mV 

• S.W. Amplitude: 1-250mV 

• S.W. Frequency: 1-2000Hz 

• Quiet Time: 0-100s 

 
The scan rate cannot be directly changed by the user, and is determined by Step Potential x S.W. Frequency. 

 
There are two advantages to measuring the difference current. First, it increases the discrimination against the 

charging current, since any residual charging current is subtracted out. Second, the shape of the current response 

is a symmetric peak (see below), rather than the sigmoidal curve typically found for normal pulse voltammetry. 

If we consider a reduction, then at potential well positive of the redox potential, both the forward and reverse 

currents are zero, so the difference current is also zero. At potentials well negative of the redox potential, the 

current is diffusion-controlled, and the potential pulse has no effect; hence, the forward and reverse currents are 

equal, and the difference current is again zero. 
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A typical square wave voltammogram 

 
Stripping Voltammetric Techniques (LSSV, SWSV, DPSV) 

Stripping voltammetry is a very sensitive method for the analysis of trace concentrations of electroactive species 

in solution. Detection limits for metal ions at sub-ppb concentrations have been reported. 

 
There are three important parts in a stripping experiment: 

• Deposition 

• Quiet time 

• Stripping 

 
These components can best be explained by discussing the stripping experiment for detection of lead. In this 

experiment, a mercury working electrode is used – either the Hanging Mercury Drop Electrode (HMDE) (using the 

BASi CGME) or the Thin Mercury Film Electrode (TMFE) (using the BASi RDE-2). The TMFE is made by depositing a 

mercury film on the surface of a glassy carbon electrode, typically during the deposition step. 

 
During the deposition step, the potential applied to the mercury electrode is held at a Deposition Potential (mV) 

at which the lead ions are reduced to lead metal for a predetermined Deposition Time (sec). If the Deposition 

E = Initial E option is enabled, the Initial Potential (mV) in the Technique Parameters is used as the deposition 

potential. The metallic lead than amalgamates with the mercury electrode (when the TMFE is used, mercuric ions 

are generally added to the solution, and mercury metal is co-deposited with the lead during the deposition step). 

The effect of this amalgamation is to concentrate the lead in the mercury electrode, and hence the concentration 

of lead in the electrode is much greater (typically 2 or 3 orders of magnitude) than the concentration of lead in 

the solution (consequently, the deposition step is often called the pre-concentration or accumulation step). The 

efficiency of the deposition can be increased by either stirring the solution (when using the CGME) or rotating the 

electrode (when using the RDE-2). Stir/Rotate during Deposition and Purge during Deposition can be enabled 

to remotely control the CGME/RDE-2. In the Cell Settings, the Cell Selection should be set to CGME/SDME Mode 

or RDE-2, depending on which is to be used. 
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After the deposition step, the stirring is stopped, and the system is allowed to reach equilibrium (typically 10-15 

seconds). This is the Quiet Time (s) found under the Start Conditions section. 

 
During the stripping step, the applied potential is scanned in a positive direction, and the lead in the mercury 

electrode is oxidized back to lead ions in solution; that is, the lead is “stripped” from the electrode. The 

potential at which the stripping occurs is related to the redox potential of the analyte, and hence the potential 

of the current peak on the stripping step can be used to identify the analyte. The magnitude of the current 

of the stripping peak is proportional to the concentration of the analyte in the mercury electrode. Since the 

concentration of the analyte in the electrode is related to its concentration in solution, the stripping peak current 

is therefore proportional to the solution concentration. 

 
A number of different wave forms have been used for the stripping step, including Linear Sweep Voltammetry 

(LSSV), Differential Pulse Voltammetry (DPSV), and Square Wave Voltammetry (SWSV). SWSV and DPSV are 

more commonly used, due to their lower detection limits. For more detailed information on specific technique 

parameters, please see the sections on Linear Sweep Voltammetry, Differential Pulse Voltammetry, and Square Wave 

Voltammetry, respectively. 

 
As noted above, it is the concentration of lead in the mercury electrode that is directly measured in the stripping 

step rather than the concentration of lead in solution. The electrode concentration can be increased by increasing 

the Deposition Time (sec) and/or the rate of stirring. The values required for these two parameters depends on 

the sensitivity of the mercury electrode, which is determined by the surface area to volume ratio (i.e., how many of 

the deposited lead atoms are on the mercury surface and hence are detectable in the stripping step). This ratio is 

considerably higher for the TMFE, so a shorter Deposition Time (sec) is required. In addition, faster stirring can 

be used with the TMFE due to the relative mechanical instability of the HMDE (i.e., the mercury drop can fall off if 

the stirring is too fast). The signal resolution is also better with the TMFE, which can be important if there is more 

than one metal ion present. 

 
However, the greater sensitivity of the TMFE can also be a disadvantage, since the solubility limit of the metal in 

the mercury can be exceeded more readily. This can lead to the formation of intermetallic compounds, which can 

affect the accuracy of the experimental results (due to e.g., shifts in the stripping potentials and depression of the 

stripping currents). One pair of metals that readily combine is zinc and copper. 

 
In order to be of use as a quantitative analytical technique, the results of a stripping experiment must be 

reproducible. Therefore, the experimental conditions must be reproducible. A second disadvantage of the TMFE 

is the relatively poor reproducibility of the film. Since the film is deposited on the surface of a glassy carbon 

electrode, it is sensitive to the microstructure of the glassy carbon surface, which can be affected by the method 

used to prepare the surface. In contrast, an HMDE is highly reproducible. Whatever the chosen mercury electrode, 

great care must be taken in sample preparation, cleaning of glassware, etc. The rate of stirring during the 

deposition step must also remain constant. 

 
The above method is called anodic stripping voltammetry (ASV), since the stripping current is anodic. This method 

can be used for metal ions that can be readily reduced to the metallic state and re-oxidized, which includes about 

20 different metal ions (e.g. lead, copper, cadmium, and zinc). This is not as many as can be detected using 

atomic absorption spectroscopy (AAS), although the sensitivity of ASV is comparable with, and sometimes better 

than AAS. The advantage of ASV over AAS is its ability to detect several metal ions simultaneously. In addition, 

different oxidation states of a given metal can be detected (e.g., arsenic and antimony). 

 
Other stripping voltammetric techniques include cathodic stripping voltammetry (CSV) and adsorptive stripping 

voltammetry (AdSV). The basis for CSV is the oxidation of mercury followed by the formation of an insoluble film of 

HgL (L is the analyte) on the surface of the mercury electrode during the deposition step. CSV is most commonly 
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used for detection of sulfur-containing molecules (e.g., thiols, thioureas, and thioamides), but it has also been 

used for molecules such as riboflavin and nucleic acid bases (e.g., adenine and cytosine). 

 
AdSV is different from ASV and CSV in that the deposition step is non-electrolytic, and occurs via the adsorption 

of molecules on the surface of the working electrode (the HMDE is most commonly used). The stripping step 

can be either anodic or cathodic. AdSV has been used for organic molecules (e.g., dopamine, chlorpromazine, 

erythromycin, dibutone, and ametryne) and for metal complexes of metals not amenable to detection by ASV (e.g., 

cobalt and nickel). 

 
BIPOTENTIOSTAT  TECHNIQUES 

Multichannel techniques are available on the Epsilon EClipse™ by the addition of the optional bipotentiostat 

upgrade. Bipotentiostat experiments can be run for cyclic voltammetry, chronoamperometry, and DC amperometry. 

 
Multi-Channel Amperometry (MCA) 

The W2 Applied Potential can be automatically set to the same value as W1 (Track W1), or a different value can 

be entered (Fixed Potential). 

 
Multi-Channel Cyclic Voltammetry (MCCV) 

There are two options available for the W2 Applied Potential: 

 
• Fixed Potential: Channel 2 is held at a set potential value, as defined by the Fixed Potential. Typical 

output from a “scan-hold” experiment is shown below. 
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• Potential Scan: Channel 2 is scanned over the same potential range and at the same scan rate as 

Channel 1 (Track W1). Typical output from a “scan-scan” experiment is shown below. 

 

 
Note that in either case, the W2 Full Scale Current must also be specified. 

 
Multi-Channel Chronoamperometry (MCCA) 

There are two options available for the W2 Applied Potential: 

• Fixed Potential: Channel 2 is held at a set potential value, as defined by the Fixed Potential. 

• Potential Step: The step potentials and times for Channel 2 are the same as those used for 

Channel 1 (Track W1). Typical output from a “step-step” experiment is shown below. 

Note that in either case, the W2 Full Scale Current must also be specified. 
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7.6. EXPERIMENT 

Run/Stop – After choosing a technique and changing the experimental parameters to the desired values, the 

experiment can be started by selecting Run in the Experiment menu or by selecting the Run icon. The experiment 

can be stopped by selecting Stop in the Experiment menu or by selecting the Stop icon. 

 
Sequential Techniques – Sequential techniques allows the user to set up a batch experiment with a virtually 

unlimited number of sequential experiments. Sequential techniques is included as part of the Methods software 

package. Sequential techniques can be entered by selecting Sequential Techniques in the Experiment menu. 

 
1. To initiate a new experiment, select the desired technique from the Available Technique list, 

and then click Insert Tech. The new experiment will be highlighted, and placed at the bottom 

of the list or after the currently highlighted technique in the sequence. 

2. The technique can be edited by highlighting the technique in the sequence and selecting 

Edit. The scan rate increment and applied E increment can be checked on or off enable and 

values can be input. 

3. To delete an experiment, highlight the appropriate experiment, and then click Delete. 

4. A previously saved sequence can be selected by clicking Open in the Tech Sequence File 

section of the Sequential Techniques dialog box. 

5. The following can be programmed to occur during the sequence – Select Insert Delay to insert 

a delay into the sequence. The delay can be edited by highlighting delay in the sequence and 

selecting Edit. The length of delay time can be selected, stir can checked on or off, purge can 

be checked on or off, and in the event relay dropdown box set off, set on, pulse off, or pulse 

on can be selected. 

6. Multiple cycles of the defined sequence of experiments can be programmed by changing the 

number of total runs in the box in the control section of the sequential techniques dialog box. 

7. Once the sequence has been programmed, select Run to start the sequence. The sequence can 

be stopped by selecting Stop. 

8. To choose the location of saved data, enter the desired location into the box in the Data Path 

section of the Sequential Techniques dialog box and click Set. 

9. A programmed Sequential Technique can be saved for future use by selecting Save in the Tech 

Sequence File section of the Sequential Techniques dialog box. 

 

7.7. GRAPHING 

The options available for the graphical display of the experimental data are listed below. These are contained in 

the Graph menu, and also in the Graph Properties window. 

 
ZOOM 

When data is displayed in an experimental window (during or after an experiment, or after opening saved data), 

the axis limits are defined by the data points, as shown below. 
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A typical graph for a cyclic voltammetry after selecting Zoom All Data 

 
Three zoom options are available: Zoom Full Range, Zoom All Data, or mouse zoom. Zoom Full Range will 

increase the y-axis to the values defined by Full Scale Current in the technique parameters. 

 
 

 
A typical graph for a cyclic voltammetry after selecting Zoom Full Range 

 
Zoom All Data will restore the default zoom on the data points. 

 
The mouse scroll-wheel can also be used to zoom in and out of data. Additionally, the user can 

define the zoom area of the window by clicking the mouse in one area of the data and dragging 

the cursor to an opposite corner while holding down the mouse button. 
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A typical graph for a cyclic voltammetry after a partial zoom with using a mouse 

 
The Undo Zoom menu selection will undo the last zoom the user implemented. 

 
CHANGE DISPLAY TYPE 

Two axes conventions are available: 

 
• IUPAC: Positive x = positive potentials; positive y = oxidative currents 

• POLAROGRAPHIC: Positive x = negative potentials; positive y = reduction currents 

 

 

IUPAC Polarographic 

 
Both graph types can be accessed from the Graph menu. 

 
SELECT GRAPH TYPE 

Many options exist for the graphing of data collecting during a technique. These options can be accessed by right- 

clicking in the graph area, or through the Graph➔Select Graph Type menu. 
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Raw vs. Processed Data 

The graph can display either raw data, or apply post-run smoothing. 

 
X- and Y-axes 

Data graphs are initially shown in their default graph type (varies per technique). There are a variety of other 

graph types that can be used to analyze the data: 

• I vs E (current vs. potential) 

• I vs t (current vs. time) 

• E vs t (potential vs. time) 

 
The following derived graph types can also be displayed: 

• Q vs t (charge vs. time) 

• Q vs sqrt(t) (Anson plot) 

• I vs 1/sqrt(t) (Cottrell plot) 

• Semi Int (integration of current vs. potential) 

• Semi Diff (differentiation of current vs. potential) 

• SW Difference (current vs. potential) 

• SW Forward (current vs. potential) 

• SW Reverse (current vs. potential) 

 
For multi-channel techniques, W1 and W2 data can be displayed together, or just one channel’s data can be 

displayed using Multichannel W1 and Multichannel W2 options. 

 
Please see section 7.5 for more information on which graph types are available for each specific technique. 
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SHOW DATA POINTS 

This option can be enabled or disabled in the Graph menu. Enabling this option will generate a 

graphic in which all the experimental data points are displayed (see example below). 
 

 
 

DATA DISPLAY SETTINGS 
 

 
This menu option allows you to set the exact extents of the displayed graph. 
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GRAPH PROPERTIES TOOLBAR 

The Graph Properties Toolbar can be accessed from the View ➔ Toolbars and Docking Window menu. This toolbar 

can be a floating window within the software, or it can be docked on the sides, top, or bottom of the software 

window. While docked, the toolbar can be left open, or it can be set to automatically hide when not in active use. 

The Graph Properties Toolbar will always show/change the settings of the active window. 

 
Captions 

All graphs have default titles and axis labels. However, the user can enter custom titles and axis labels in this 

section of the Graph Properties Toolbar. 

 
Fonts 

Fonts can be adjusted independently for the graph title, the axis labels, and the axis tick mark values. 

 
Colors 

All of the various features in the graph can be set to any color, or the graph can be displayed in Black and White 

Mode. 

 
Show 

In this section of the Graph Properties Toolbar, the grid lines and axis settings can be changed. The Grid can be 

enabled or disabled. The Zero Line for either axis can be also be enabled or displayed, regardless of whether the 

overall grid is displayed. Data Points can also be enabled or disabled in this section of the toolbar. 
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7.8. DATA ANALYSIS 

The parameters that can be extracted from experimental data depend upon the electrochemical technique 

(e.g., peak potential, peak current, and peak area for cyclic voltammetry, and slope and intercept for 

chronoamperometry/chronocoulometry). Therefore, different measurement methods are required for different 

techniques. The following data analysis methods are available on the Epsilon EClipse™. 

 
PEAK PARAMETERS 

This function can be found in the Analysis menu under Peak Parameters. This function will measure and report 

the peak potential, current, and area under the peak for symmetric and tailing peaks, and the half-wave potential 

and limiting current for sigmoidal curves. The baselines for these measurements can either be determined 

automatically by the software or manually by the user. The operation of this function is best illustrated by the 

example below. 

 
 

 
The cyclic voltammogram to be analyzed is shown above. The peak parameter values are calculated using the 

default values for the peak finding function. 
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The peaks found will be based on the Min Width and Min Height parameters. After changing these values, click 

the Calculate button to recalculate the peaks. 

 
Selecting a peak will show only that peak on the graph. Click the Redraw button to restore the view with all 

peaks. 

 
Checking the Paint Peaks box and the clicking Redraw will show the calculated area for each peak. 

 

 
All peak baselines and peak lines are saved with the data file. If one reanalyzes saved data, then be sure 

to resave the file. 
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LINEAR FIT MEASUREMENT 

Data from potential step experiments can be analyzed using the linear relationship between the 

response and some function of time. While viewing a data file, change the graph type to Q vs sqrt(t) or 

I vs 1/sqrt(t). Then select Calculate CA-SIR from the Analysis menu. 

 
There are two parameters to be specified for the linear fit. R-Window specified the percentage of data 

points to be used in the fit. This parameter is required since the finite time required to change the 

potential from the initial value to the step value means that the first few data points are not valid. The 

default condition is that the final 80% of the data points are used for the calculation (i.e. the first 20% 

are discarded). W is the weighting factor used in the calculation (x, 1/x, or 1/x2). On clicking Calculate, 

the parameter values are calculated and displayed in the window (see figure below). 

 

 

The graph now displays the lines used for the calculations. 
 

 

 
FILE OVERLAY 

Data files can be superimposed on a single set of axes using the Overlay Waveforms function in the Graph menu. 

Open all the files you wish to overlay, and the overlay will automatically be generated when you select the menu 

option. The axis scale is determined by the graph with the largest extents. 

 
If you wish to remove one of the graphs from the overlay, simply close that file and it will disappear. 
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Please note that the Graph Properties menu is not active for overlays. 

 
Overlays can be saved as *.eplot files. When reopening this file, the original data files must first be opened. 

 
MOVING POINT AVERAGING 

Digital smoothing routines are used to remove unwanted noise from the electrochemical signal after the 

experimental run, thereby improving the signal-to-noise ratio. However, as with analog filtering, care must be 

taken to avoid biasing the electrochemical signal. 

 
The default smoothing routine on the Epsilon EClipse™ is the moving average smooth. This can be selected in 

the Analysis menu under three options: MPA 5 Points, MPA 9 Points, or MPA n Points. For example, when using 

MPA 5 Points, data are examined in 5 point blocks. Within each block, the first, second, fourth, and firth points 

are summed and divided by 4. This number (i.e. an averaged current value) replaces the third point in the block. 

The routing moves up one point, and repeats the averaging sequence, until it has been repeated for all data 

points, other than the first two and last two, which are set equal to the third point, and the third from last point, 

respectively. A 9 point moving point average is also available, or the user may set any n value. 

 
The default condition is that the experimental data is smoothed automatically at the end of the experiment. 

 
DERIVED GRAPHS 

Various derived graphs are available, depending on the technique: 

 
Anson Plots 

This plot of Q vs. t is available for chronocoulometric techniques. 

 
Cottrell Plots 

This plot of I vs. 1/t is available for chronoamperometric techniques. 

 
These plots can be accessed by right-clicking on the data graph and selecting Derived Graphs. They can also be 

accessed from the Graph➔Select Graph Type menu option. 
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7.9. DATA STORAGE AND EXPORT 
 

SAVING 

Data can be saved with the .edata file extension by selecting Save or Save As from the File menu or by selecting the Save 

icon on the tool bar. The technique can be saved with the .etech file extension by selecting Save or Save As from the File 

menu or by selecting the Save icon on the tool bar. If using the Methods version of the software, a sequence can be saved 

with the .eseq file extension by selecting Save or Save As from the File menu or by selecting the Save icon on the tool bar. 

 
COPYING 

Data can be copied by selecting Copy in the Edit menu. The graph can also be copied by pressing Ctrl+C when the 

graph window is active. Plot data can be copied by pressing Ctrl+Shift+C for directly pasting into a spreadsheet. 

 
PRINTING 

Information can be printed by selecting Print in the File menu or by selecting the Print icon on the tool bar. Also, 

Print Preview and Print Setup can be selected in the File menu. Graphs are printed with the technique parameters 

and notes given below the graph. Graphs can be printed to PDF files if an applicable PDF writer is installed on the 

computer. 

 
EXPORTING 

Data can be exported by selecting Save Data As from the File menu and allows for the selection of several 

options. Technique Properties, Legacy Format, Measured Parameter(s) Only, Single Column, and Column Labels can 

be checked or unchecked. The Column Delimiter can be chosen to be Space, Comma, or Tab. The option to save the 

data every n number of data points can be chosen by entering the desired numerical value into the box. 

 

7.10. SHORTCUT KEYS 
 

DEFAULT SHORTCUT KEYS 

Default Shortcut Keys 

Ctrl-C – Copy graph image. 

Ctrl-P – Print. 

Ctrl-N – New Technique. 

Ctrl-O – Open file. 

Ctrl-F4 – Close current technique. 

Selection box - Zoom to selection. 

Shift - Display coordinates at pointer. 

Shift-double click - Toggle display points. 

Arrow keys - Pan zoom. 

 

 
Mouse Wheel - Zoom in/out. 

Shift-left and -right keys - Switch between 

runs in multirun. 

Secondary (Right) mouse - Context menu. 

F5 - Run current technique. 

F7 - Apply MPA(9). 

Ctrl-F7 - MPA(n), use the menu to select 

the number of points. 

F9 - Turn cell off if active. 

Ctrl-Shift-C - Copy data points from graph. 
 

CUSTOMIZE 

Shortcut keys can be added or modified for a number of operations within the software. In the View drop down 

menu select Toolbars and Docking Windows, then select Customize. In the Customize window, select the 

keyboard tab. In this tab, any category (menu) can be selected and the current shortcut keys are shown. New 

shortcut keys can be entered for any command. 
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8. MAINTENANCE AND TROUBLESHOOTING 

8.1. WORKING ELECTRODES 
 

ELECTRODE POLISHING 

The fundamental process in electrochemical reactions is the transfer of electrons between the working electrode 

surface and molecules in the interfacial region (either in solution or immobilized at the electrode surface). The 

kinetics of this heterogeneous process can be significantly affected by the microstructure and roughness of the 

electrode surface, the blocking of active sites on the electrode surface by adsorbed materials, and the nature of the 

functional groups (e.g., oxides) present on the surface. Therefore, there has been considerable effort devoted to 

finding methods that remove adsorbed species from the electrode and produce an electrode surface that generates 

reproducible results. The most common method for surface preparation is mechanical polishing. The protocol used 

for polishing depends on the application for which the electrode is being used, and the state of the electrode 

surface. There are a variety of different materials available (e.g., diamond, alumina, silicon carbide), with different 

particle sizes suspended in solution (BASi supplies 0.05 mm alumina polish, and 1, 3, 6, and 15 mm diamond 

polishes; these should be shaken well before use to ensure that the particles are suspended). The pad used for 

polishing also depends on the material being used for polishing pads are used with alumina polish, and nylon pads 

should be used with diamond polish. Working electrodes supplied by BASi have first been lapped to produce a flat 

surface, and have then been extensively polished to a smooth, mirror-like finish at the factory. Therefore, they 

typically only require repolishing with 0.05 mm or 1 mm diamond polish by the user between experiments. The 

electrode should be moved in a figure-of-eight motion when polishing to ensure uniform polishing. Materials that 

have a rougher surface (e.g., commercial electrodes that have been scratched) must first be polished using a larger 

particle polish, in order to remove the surface defects. After the defects have been removed, the polishing should 

continue with successively smaller particle size polish (e.g., 15 mm, then 6 mm, then 3 mm, and then 1 mm). 

 
 

 

MF-2060 Electrode modifier – PK-4 electrode polishing kit 
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Once polishing has been completed (this can require from 30 s to several minutes, depending upon the state of 

the electrode), the electrode surface must be rinsed thoroughly with an appropriate solvent to remove all traces 

of the polishing material (since its presence can affect the electron transfer kinetics). Alumina polishes should 

be rinsed with distilled water, and diamond polishes with methanol or ethanol. The rinsing solution should be 

sprayed directly onto the electrode surface. After the surface has been rinsed, electrodes polished with alumina 

should also be sonicated in distilled water for a few minutes to ensure complete removal of the alumina particles. 

If more than one type of polish is used, then the electrode surface should be thoroughly rinsed between the 

different polishes. As discussed above, the effect of any surface pretreatment can be determined by its effect on 

the rate of electron transfer. This can be judged qualitatively by examining the separation of the peak potentials 

in a cyclic voltammogram of a molecule whose electron transfer kinetics are known to be sensitive to the 

state of the surface (a more quantitative determination can be made by calculating the value of the standard 

heterogeneous rate constant ks from this peak potential separation). For example, ks for potassium ferricyanide 

at a glassy carbon surface following a simple polishing protocol is typically in the range 0.01 - 0.001 cm s-1 

(this should be compared with the values measured for ks for a platinum electrode, which are at least one order 

of magnitude larger). The strong dependence of the electron transfer kinetics of ferricyanide on the state of 

the electrode surface means that there can be significant variations in the peak potential separation after each 

polishing, since polishing alters the microstructure, roughness, and functional groups of the electrode surface in 

addition to removing adsorbed species. The materials used for the polishing can also affect the value of ks. For 

example, the electrode surface can be contaminated by the agglomerating agents required to keep the alumina 

particles suspended in solution and by the components of the polishing pad. The presence of these species can 

have a deleterious effect on the electron transfer kinetics by blocking the active sites for the electron transfer 

reaction. However, it should be noted that such pronounced dependence on the state of the electrode surface is 

only observed for certain systems (the most well characterized examples are the reduction of ferricyanide, the 

oxidation of ascorbate, and the adsorption of dopamine). For such systems, polishing is often used in combination 

with another pretreatment (e.g., heat or electrochemical). However, for many other systems, the simple polishing 

described above is adequate (for example, when using nonaqueous electrolytes, since blocking of active sites by 

adsorbed species is less common in such electrolytes than it is in aqueous electrolytes). 

 
ELECTROCHEMICAL PRETREATMENT 

Another method for preparation of the electrode surface that is becoming more widely used is electrochemical 

pretreatment (ECP), particularly for electrodes which cannot readily be polished (e.g., carbon fiber cylinder 

electrodes). ECP consists of applying conditioning potentials to the electrode surface before the experiment. 

As with polishing, this has the effect of removing adsorbed species and altering the microstructure, roughness 

and functional groups of the electrode surface. The precise ECP protocol depends upon the application, and 

varies considerably. The potential waveforms typically are either held at, or cycle to, a large positive or negative 

potential, either using steps or sweeps (constant potential, potential scan, triangular wave, and square wave). 

Although the development of the preconditioning protocols has been largely empirical, there has been some 

characterization of the pretreated electrode surface in order to elucidate the reasons for the activation of the 

electrode surface. For glassy carbon electrode, in addition to the removal of adsorbed species, the preconditioning 

potential leads to the formation of an oxygen-rich layer on the carbon surface. This layer contains oxides as well 

as other oxygen-containing functional groups which may catalyze electron transfer reactions (the composition 

of the functional groups in this layer is sensitive to the pretreatment conditions, and depends on the solution 

pH as well as the potentials used for the pretreatment). The oxide layer can also adsorb and/or exchange ions 

from the solution, which leads to improved detection limits. However, electrochemical pretreatment of electrodes 

can increase the background current of the electrode relative to that of a polished electrode, which may be 

disadvantageous for some applications. 
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8.2. REFERENCE ELECTRODES 
 

INTRODUCTION 

In all electrochemical experiments, the reactions of interest occur at the surface of the working electrode. 

Therefore, we are interested in controlling the potential drop across the interface between the surface of the 

working electrode and the solution (i.e., the interfacial potential). However, it is impossible to control or measure 

this interfacial potential without placing another electrode in the solution. Thus, two interfacial potentials must 

be considered, neither of which can be measured independently. Hence, one requirement for this counter electrode 

is that its interfacial potential remains constant, so that any changes in the cell potential produce identical 

changes in the working electrode interfacial potential. An electrode whose potential does not vary with current is 

referred to an ideal non-polarizable electrode, and is characterized by a vertical region on a current vs. potential 

plot. However, there is no electrode that behaves in this way (although some approach ideal non-polarizable 

behavior at low currents). Consequently, the interfacial potential of the counter electrode in the twoelectrode 

system discussed above varies as current is passed through the cell. This problem is overcome by using a three- 

electrode system, in which the functions of the counter electrode are divided between the reference and auxiliary 

electrodes; that is, the potential between the working and reference electrodes is controlled and the current 

passes between the working and auxiliary electrodes. The current passing through the reference electrode is further 

diminished by using a high-input-impedance operational amplifier for the reference electrode input. 

 
The requirements for the counter electrode of the two-electrode system include a high exchange current (fast 

electron transfer kinetics), very large surface area (to lower the current density) and a high concentration of the 

species involved in the redox reaction, such that the concentrations are not significantly changed by the passage 

of a current. One previously widely used reference electrode that fulfills these criteria is the saturated calomel 

electrode (with a large surface area mercury pool). However, since the current passing through the reference 

electrode in the three-electrode system is many orders of magnitude lower than the current that passes through 

the two-electrode system, the requirements for the reference electrode are less demanding; hence, smaller, more 

polarizable electrodes can be used. 

 
One aspect that is often overlooked is the variation of the reference electrode potential with temperature. 

Ideally, the potential should be temperature independent; however, it typically changes by 0.5 - 1 mV per degree 

Celsius. Consequently, precise potential measurements require the use of a constant temperature apparatus. In 

addition, the temperature at which the measurements were carried should always be reported. The absence of any 

temperature control limits the accuracy of the measurements to about 5 - 10 mV (although this level of precision 

may be acceptable for some experiments). Two widely used aqueous reference electrodes are the silver/silver 

chloride electrode and the saturated calomel electrode. These are now discussed in more detail. 

 
SILVER/SILVER CHLORIDE REFERENCE ELECTRODE 

The redox process for this electrode is 

 
 

 
This electrode consists of a silver wire, coated with silver chloride, which is immersed in a solution containing 

chloride ions. The BASi RE-5B electrode uses an aqueous solution containing 3M sodium chloride (the use of 

sodium as the cation rather than potassium is discussed below); a porous CoralPor™ frit is used for the junction 

between the reference electrode solution and the sample solution. The potential E for any electrode is determined 

by the Nernst equation, which relates E to the standard potential Eo and the activities of the redox components 

(the standard potential is the potential of the electrode at unit activity under standard conditions). The Nernst 
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equation for the silver/silver chloride electrode is given below (activities of the solid silver and silver chloride 

under standard conditions are unity). 

 

 
It is generally more convenient to consider concentrations rather than activities. These parameters are 

related by the activity coefficient y: 

 
 

 

 
 

The Nernst equation can therefore be rewritten as follows: 

 

 

where Eo is the formal potential and is related to the standard potential by the equation: 

 

 

When quoting a redox potential, it is important to be specific. For example, the standard redox potential (Eo) for 

the silver/silver chloride redox reaction at 25 ºC is +0.222 V (vs. NHE), whereas the redox potential (E) for the 

BASi aqueous silver/silver chloride with 3M sodium chloride reference electrode at this temperature is +0.209 V 

(vs. NHE). The above equations show that variations in the chloride ion concentration in the electrode change the 

redox potential. Since there is generally a large chloride concentration gradient across the reference electrode frit, 

there is slow diffusion of chloride ions from the reference electrode solution into the sample solution; that is, the 

reference potential will gradually change when used. There are some precautions that can be taken to minimize 

this potential drift. When the electrodes are made, the CoralPor™ frit is covered in plastic to prevent leakage. This 

plastic should be carefully removed immediately upon receipt, and the CoralPor™ frit should be immersed in a 3M 

aqueous sodium chloride solution. The reference electrode should also be removed from the electrochemical cell 

and stored in this solution between experiments (this is particularly important when using non-aqueous solvent 

systems, for reasons discussed below). Occasionally, air bubbles will form in the solution next to the CoralPor™ 

frit; these should be removed by gently flicking the end of the electrode. 
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SATURATED CALOMEL REFERENCE ELECTRODE 

The redox process for this electrode is 

 

 

 

The BASi saturated calomel electrode (SCE) is an H-cell. One arm contains mercury covered by a layer of 

mercury(II) chloride (calomel). This is in contact with a saturated solution of potassium chloride; a porous 

CoralPorTM frit is again used for the junction between the reference electrode solution and the sample solution at 

the end of the other arm. The saturated calomel electrode is provided as a kit requiring user assembly (N.B. the kit 

does NOT include any mercury). Once assembled, the electrode should be stored with the CoralPorTM frit immersed 

in a saturated solution of potassium chloride to maintain the chloride concentration in the reference electrode. 

 
LIQUID JUNCTIONS POTENTIALS 

As noted above, the composition of the reference electrode solution (i.e., high chloride ion concentration) is 

generally different from the composition of the sample solution. This leads to a potential difference across the 

interface of the two solutions (i.e., the CoralPor™ frit), due to unequal rates of diffusion of the constituent ions 

through the frit. This liquid junction potential cannot be measured (although it can be estimated), and can cause 

problems with voltammetric measurements. For example, the redox potentials of a given analyte measured in 

different solvent systems cannot be directly compared, since the liquid junction potential will be different for each 

solvent system. However, the junction potential can generally be ignored for a given solvent system provided it 

is constant and reproducible. If there is any doubt that this is so, an internal reference (e.g., ferrocene) can be 

used; that is, the reference compound is added to the sample solution at the end of the experiment, and its redox 

potential is recorded. This approach can also be used to compare redox potentials measured in different solvent 

systems. 

 
USING AQUEOUS REFERENCE ELECTRODES IN NON-AQUEOUS SOLVENTS 

There has been much debate over the use of aqueous reference electrodes such as the silver/silver chloride 

electrode and saturated calomel electrode with non-aqueous solvent systems. One area of concern is the junction 

potentials across the salt bridge, which can range from tens to hundreds of millivolts; however, as discussed above, 

such problems can be compensated for by the use of an internal reference. There are two more serious problems; 

the precipitation of electrolyte and the contamination of the sample solution. The electrolytes commonly used 

in reference electrodes (sodium and potassium chloride) are not very soluble in organic solvents, and prolonged 

immersion of aqueous reference electrodes in organic solvents can lead to precipitation of these electrolytes 

in the CoralPor™ frit. Salts that are combinations of the ions of the two electrolytes can also be precipitated; 

for example, potassium perchlorate is insoluble in acetonitrile, and can be deposited in the frit of an aqueous 

potassium chloride reference electrode in an acetonitrile solution of tetraethyl ammonium perchlorate. Such 

precipitation can be avoided by judicious choice of electrolytes. For example, sodium perchlorate is much more 

soluble that potassium perchlorate, so sodium chloride is used in BASi silver/silver chloride reference electrodes 

rather than potassium chloride. Tetraethylammonium chloride has also been used as the reference electrode 

electrolyte; since it is soluble in both aqueous and non-aqueous media (such reference electrodes are not available 

commercially). The precipitation of electrolyte salts increases the reference electrode impedance and changes 

the liquid junction potential, which causes the reference potential to change with time. Therefore, prolonged 

exposure to organic solvents should typically be avoided, and the stability of the reference potential should be 

regularly checked (by using an internal reference or by comparing with another reference electrode). However, 

aqueous reference electrodes can be used for bulk electrolysis experiments in non-aqueous solvents, since a large 
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overpotential is typically used and the small potential drift that occurs during the experiment should therefore 

have little effect (although the magnitude of the potential change should be checked after the experiment). 

 
Another potentially serious problem that can occur is contamination of the sample solution by components of 

the reference electrode solution (e.g., water and chloride ions). For example, many organometallic compounds 

are highly reactive to water, and hence cannot be exposed to the small amounts of water that diffuse from the 

reference electrode during the experiment. One approach that has been used to overcome this has been the use 

of ‘double-junction’ reference electrodes, in which the aqueous reference electrode is isolated from the sample 

solution using a salt bridge containing a nonaqueous solvent/electrolyte system. However, this approach does 

not rigorously exclude water, so it is not appropriate for highly-water sensitive systems. In addition, there are 

disadvantages to this approach, as the introduction of the second junction not only alters the reference potential 

by the addition of another junction potential, it also increases the impedance of the reference electrode. Another 

reference electrode modification that can be particularly appropriate for non-aqueous systems is the use of a 

Luggin capillary. This allows the tip of the reference electrode to be placed very close to the working electrode 

surface, thereby decreasing the uncompensated solution resistance (Ru) between the reference and working 

electrodes. However, exact placement of the Luggin probe is required in order to obtain reproducible resistance 

compensation; in addition, if the tip is too close, part of the electrode surface is blocked, which leads to non- 

uniform current distribution. The Luggin capillary also increases the reference electrode impedance. 

 
There are two reference electrode systems that do not require water, and hence are suitable for nonaqueous 

electrochemistry of water-sensitive systems. These are the pseudo-reference electrode and the silver/silver ion 

electrode. 

 
PSEUDO-REFERENCE ELECTRODES 

Pseudo-reference electrodes are simply metal wires (e.g., platinum or silver) immersed in the sample solution. 

Although such electrodes do provide a constant potential, the reference potential is unknown, and is dependent 

on the composition of the sample solution. Consequently, redox potentials measured using a pseudo-reference 

electrode should be quoted relative to redox potential of the internal reference compound. One advantage of 

pseudo-reference electrodes is their low impedance. 

 
SILVER/SILVER  ION  ELECTRODE 

The redox process for this electrode is 

 

 

 

This electrode is less stable than the aqueous electrodes discussed above (due to diffusion of silver ions out 

of the electrode and the photoreactivity of these ions), and must be prepared frequently. BASi provides a non- 

aqueous reference electrode kit, which requires assembly by the user. The BASi nonaqueous reference electrode 

consists of a silver wire immersed in a solution of silver nitrate or perchlorate (0.001M to 0.01M) and electrolyte 

(e.g., 0.1M TBAP) in the desired organic solvent. Suitable organic solvents include acetonitrile, dimethylsulfoxide 

(DMSO), methanol, ethanol and tetrahydrofuran (THF). Silver ions are reduced by dimethylformamide (DMF) 

and are insoluble in methylene chloride; these solvents are therefore not suitable for this reference electrode 

(acetonitrile can be used as the reference electrode solvent when one of these other two solvents is used for the 

sample solution). The potential for the silver/silver ion reference electrode depends on the solvent, the silver ion 

concentration as well as the nature and concentration of the electrolyte. It is also changed by the introduction of 

salt bridges, which are used to decrease contamination of the sample solution by silver ions. 
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REFERENCE ELECTRODE IMPEDANCE 

The impedance of the reference can have a significant effect on the current response of the cell. A high impedance 

reference electrode can not only slow the response of the potentiostat (slow rise time), it also increases the 

susceptibility of the system to environmental noise (particularly power line noise). There are a number of factors 

that can increase the impedance (see above), and the construction of the reference electrode can require careful 

consideration. 

 

8.3. TROUBLESHOOTING 

Epsilon EClipse™ will not link with computer and following dialog box appears: 
 

 

 

 
1. Select Reconnect Epsilon under the Instrument menu. 

2. Check that the Epsilon EClipse™ is turned on. 

3. Check the USB cable between computer and Epsilon EClipse™. 

 
The Epsilon EClipse™ appears to have an electronics problem. 

 
Perform the following analog electronics test. 

1. Open a New Cyclic Voltammetry experiment and set the parameters as shown below. The 

Celle Selection should be set to Internal Dummy Cell 10k. 
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2. Run the experiment. The plot should be a sloping line going through 0 from -0.1 mA to 0.1 mA 

(as shown below). If the Epsilon EClipse™ passes this test, then the problem could be in the cell 

lead, but is more likely to be with the cell. 
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All LED’s on front panel stay lit after power up. 

Call BASi service. 

 
Some techniques are marked demo. 

If some techniques are marked demo, then they have not been enabled in that particular Epsilon EClipse™ 

instrument. Contact BASi for price quote to add the additional techniques to the instrument. 

 
Fan Filter 

The Epsilon EClipse™ uses a cooling fan to prevent overheating. The fan has a filter which prevents dust from 

entering the instrument. As dust accumulates, the volume of airflow will decrease, thus reducing the cooling 

efficiency. 

 
CLEAN THE FAN FILTER EVERY THREE MONTHS, OR MORE OFTEN IF VISIBLY DIRTY. 

 
Clean the filter as follows: 

 
1. Grip the fan filter retainer on both sides and gently pull off. If necessary, you can use a flat 

screwdriver (or other similar tool) to gently pry up the tabs on the top and sides of the filter 

retainer (see below). 

 

 
2. Remove the filter from the retainer. 

3. You may vacuum the filter or wash it in warm sudsy water. Be careful not to tear it. 

4. If you’ve washed the filter, blot it well between sheets of paper towels, and then allow it to 

dry. 

5. Reinstall the filter in the retainer. Hold both parts in place over the fan opening, then gently 

snap the four retaining clips in place. 

 
Contact BASi if you need replacement parts. 
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